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END-USER LICENSE AGREEMENT FOR HME PC30ATM SOFTWARE 
 
IMPORTANT — READ CAREFULLY:    This HME End-User License Agreement 
("AGREEMENT") is a legal agreement between you (either an individual or a single entity) 
and HM Electronics, Inc. (“HME”) for the HME software product PC30ATM, which includes 
computer software and may include associated registration files, media, printed materials, 
sample documents, and "online" or electronic documentation ("SOFTWARE PRODUCT"). 
The SOFTWARE PRODUCT also includes any updates and supplements to the original 
SOFTWARE PRODUCT provided to you by HME. Any software provided along with the 
SOFTWARE PRODUCT that is associated with a separate end-user license agreement is 
licensed to you under the terms of that license agreement.  
 
 

 
 
SOFTWARE PRODUCT LICENSE 
 
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well 
as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.  
 
1) GRANT OF LICENSE.  This AGREEMENT grants you the following rights:  
 

a) Applications Software.  As an individual, you are granted a world-wide non-exclusive license, which 
includes only the right to install, use, access, display, run, or otherwise interact with ("RUN") one copy of 
the SOFTWARE PRODUCT, or any prior version for the same operating system, on a single computer.   
If you are an entity, you are granted the right to designate one individual within your organization to have 
the right to use the SOFTWARE PRODUCT in the manner provided above. 
 
b) Storage/Network Use.  As an alternative to installing the SOFTWARE PRODUCT on a dedicated 
computer, you may store or install the SOFTWARE PRODUCT on a storage device, such as a network 
server, used only to RUN the SOFTWARE PRODUCT on your other COMPUTERS over an internal 
network; however, you must acquire and dedicate a license for each separate COMPUTER on which the 
SOFTWARE PRODUCT is RUN from the storage device.  A license for the SOFTWARE PRODUCT may 
not be shared or used concurrently on or by different COMPUTERS. 
 
c) Reservation of Rights.  All rights not expressly granted are reserved by HME.  
 

2) DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.  
 

a) Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse 
engineer, decompile, or disassemble the SOFTWARE PRODUCT. 
 
b) Separation of Components.  The SOFTWARE PRODUCT is licensed as a single product. Its 
component parts may not be separated for use on more than one COMPUTER. 
 
c) Trademarks.  This AGREEMENT does not grant you any rights in connection with any trademarks or 
service marks of HME. 
 
d) Rental.  You may not rent, lease, or lend the SOFTWARE PRODUCT. 
 

By installing, copying, downloading, accessing, or otherwise using the SOFTWARE 
PRODUCT, you agree to be bound by the terms of this AGREEMENT. If you do not agree 
to the terms of this AGREEMENT, do not install or use the SOFTWARE PRODUCT; you 
may, however, return it to your place of purchase for a full refund. 



e) Support Services.  HME may provide you with support services related to the SOFTWARE 
PRODUCT ("Support Services").  Use of Support Services is governed by the HME policies and 
programs described in the user manual, in "online" documentation, and/or in other HME-provided 
materials.  Any supplemental software code provided to you as part of the Support Services shall be 
considered part of the SOFTWARE PRODUCT and subject to the terms and conditions of this 
AGREEMENT.  With respect to technical information you provide to HME as part of the Support Services, 
HME may use such information for its business purposes, including for product support and development.  
HME will not utilize such technical information in a form that personally identifies you. 
 
f) Software Transfer.  The initial licensee of the SOFTWARE PRODUCT may make a one-time 
permanent transfer of this AGREEMENT and SOFTWARE PRODUCT only directly to an end user.  This 
transfer must include all of the SOFTWARE PRODUCT (including all component parts, the media and 
printed materials, any upgrades, this AGREEMENT, and, if applicable, the Certificate of Authenticity).  
Such transfer may not be by way of consignment or any other indirect transfer.  The transferee of such 
one-time transfer must agree to comply with the terms of this AGREEMENT, including the obligation not 
to further transfer this AGREEMENT and/or SOFTWARE PRODUCT. 
 
g) Termination.  Without prejudice to any other rights, HME may terminate this AGREEMENT if you fail 
to comply with the terms and conditions of this AGREEMENT.  In such event, you must destroy all copies 
of the SOFTWARE PRODUCT and all of its component parts.  
 

3) UPGRADES.  If the SOFTWARE PRODUCT is labeled as an upgrade, you must be properly licensed to 
use a product identified by HME as being eligible for the upgrade in order to use the SOFTWARE PRODUCT.  
A SOFTWARE PRODUCT labeled as an upgrade replaces and/or supplements (and may disable) the 
product that formed the basis for your eligibility for the upgrade.  You may use the resulting upgraded product 
only in accordance with the terms of this AGREEMENT.  If the SOFTWARE PRODUCT is an upgrade of a 
component of a package of software programs that you licensed as a single product, the SOFTWARE 
PRODUCT may be used and transferred only as part of that single product package and may not be 
separated for use on more than one COMPUTER. 
 
4) COPYRIGHT.   All title and copyrights in and to the SOFTWARE PRODUCT (including but not limited to 
its code, appearance, structure, organization along with any documents, forms, text, and images incorporated 
into the SOFTWARE PRODUCT), the accompanying printed materials, and any copies of the SOFTWARE 
PRODUCT are owned by HME or its suppliers.  All title and intellectual property rights in and to the content 
that may be accessed through use of the SOFTWARE PRODUCT are the property of the respective content 
owner and may be protected by applicable copyright or other intellectual property laws and treaties.  This 
AGREEMENT grants you no rights to use such content.  If this SOFTWARE PRODUCT contains 
documentation that is provided only in electronic form, you may print one copy of such electronic 
documentation.  You may not copy the printed materials accompanying the SOFTWARE PRODUCT. 
 
5) BACKUP COPY.   After installation of one copy of the SOFTWARE PRODUCT pursuant to this 
AGREEMENT, you may keep the original media on which the SOFTWARE PRODUCT was provided by HME 
solely for backup or archival purposes.  If the original media is required to use the SOFTWARE PRODUCT on 
the COMPUTER, you may make one copy of the SOFTWARE PRODUCT solely for backup or archival 
purposes.  Except as expressly provided in this AGREEMENT, you may not otherwise make copies of the 
SOFTWARE PRODUCT or the printed materials accompanying the SOFTWARE PRODUCT. 
 
6) EXPORT RESTRICTIONS.   You agree that you will not export or re-export the SOFTWARE PRODUCT, 
any part thereof, or any process or service that is the direct product of the SOFTWARE PRODUCT (the 
foregoing collectively referred to as the “Restricted Components”), to any country, person or entity subject to 
U.S. export restrictions.  You specifically agree not to export or re-export any of the Restricted Components (i) 
to any country to which the U.S. has embargoed or restricted the export of goods or services, which currently 
include, but are not necessarily limited to Cuba, Iran, Iraq, Libya, North Korea, Sudan and Syria, or to any 
national of any such country, wherever located, who intends to transmit or transport the Restricted 
Components back to such country; (ii) to any person or entity who you know or have reason to know will 
utilize the Restricted Components in the design, development or production of nuclear, chemical or biological 
weapons; or (iii) to any person or entity who has been prohibited from participating in U.S. export transactions 
by any federal agency of the U.S. government.  You warrant and represent that neither the BXA nor any other 
U.S. federal agency has suspended, revoked or denied your export privileges. 



7) NO LEGAL ADVICE.  You agree and acknowledge that HME is not engaged in rendering legal, 
accounting, or other professional advice.  If legal advice or other expert assistance is required, the services of 
a competent professional person should be sought.  Any sample documents included with the SOFTWARE 
PRODUCT are for illustration only and should not be used as the basis for any transaction or advice. 
 
8)      MISCELLANEOUS 
 

a) If you acquired this SOFTWARE PRODUCT in the United States, this AGREEMENT is governed by 
the laws of the State of California. 
 
b) If you acquired this SOFTWARE PRODUCT in Canada, unless expressly prohibited by local law, this 
AGREEMENT is governed by the laws in force in the Province of Ontario, Canada; and, in respect of any 
dispute which may arise hereunder, you consent to the jurisdiction of the federal and provincial courts 
sitting in Toronto, Ontario. If this SOFTWARE PRODUCT was acquired outside the United States, then 
local law may apply. 
 
c) If you have any questions concerning this AGREEMENT, or if you desire to contact HME for any 
reason, please write to:  HM Electronics, Inc., 14110 Stowe Drive, Poway, California 92064, U.S.A. 
 

9) LIMITED WARRANTY 
 

a) LIMITED WARRANTY FOR SOFTWARE PRODUCTS ACQUIRED IN THE U.S. AND CANADA.  
HME warrants that (a) the SOFTWARE PRODUCT will perform substantially in accordance with the 
accompanying written materials for a period of ninety (90) days from the date of receipt, and (b) any 
Support Services provided by HME shall be substantially as described in applicable written materials 
provided to you by HME, and HME support engineers will make commercially reasonable efforts to solve 
any problem issues.  Some states and jurisdictions do not allow limitations on duration of an implied 
warranty, so the above limitation may not apply to you.  To the extent allowed by applicable law and not 
disclaimed in this Agreement, implied warranties on the SOFTWARE PRODUCT, if any, are limited to 
ninety (90) days. 
 
b) CUSTOMER REMEDIES.   HME’s and its suppliers’ entire liability and your exclusive remedy shall 
be, at HME’s option, either (a) return of the price paid, if any, or (b) repair or replacement of the 
SOFTWARE PRODUCT that does not meet HME’s Limited Warranty and which is returned to HME with a 
copy of your receipt.  This Limited Warranty is void if failure of the SOFTWARE PRODUCT has resulted 
from accident, abuse, or misapplication.  Any replacement SOFTWARE PRODUCT will be warranted for 
the remainder of the original warranty period or thirty (30) days, whichever is longer.  Outside the United 
States, neither these remedies nor any product support services offered by HME are available without 
proof of purchase from an authorized international source. 
 
c) NO OTHER WARRANTIES.   THE LIMITED WARRANTY ABOVE IS EXCLUSIVE AND IN LIEU OF 
ALL OTHER CONDITIONS AND WARRANTIES FOR THE SOFTWARE AND DOCUMENTATION.  HME 
AND ITS SUPPLIERS MAKE NO OTHER CONDITIONS OR WARRANTIES, EXPRESS, IMPLIED, 
STATUTORY OR OTHERWISE, AND EXPRESSLY DISCLAIM ALL OTHER CONDITIONS AND 
WARRANTIES, INCLUDING BUT NOT LIMITED TO IMPLIED CONDITIONS OR IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND 
NONINFRINGEMENT FOR THE SOFTWARE AND DOCUMENTATION, TO THE FULLEST EXTENT 
PERMITTED BY APPLICABLE LAW.  
 
d) LIMITED LIABILITY.   TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO 
EVENT AND UNDER NO LEGAL THEORY SHALL HME OR ITS SUPPLIERS BE LIABLE TO YOU FOR 
ANY COSTS OF SUBSTITUTE PRODUCTS, OR FOR ANY CONSEQUENTIAL, SPECIAL, 
INCIDENTAL, PUNITIVE OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE LICENSE 
OF, USE OF, OR INABILITY TO USE ANY HME SOFTWARE OR DOCUMENTATION, EVEN IF HME 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  IN NO EVENT SHALL HME'S OR 
ITS SUPPLIERS' LIABILITY EXCEED THE LICENSE FEE PAID BY YOU.  THIS LIMITATION OF 
LIABILITY AND RISKS IS REFLECTED IN THE PRICE OF THE SOFTWARE LICENSE. 

 



10) AUDIT.   During the term of this Agreement and for three (3) years after termination or expiration, you will 
maintain complete records regarding your use and distribution of the Software.  Upon reasonable notice to 
you, HME may audit, at HME's expense, your books and records to determine your compliance hereunder.  In 
the event any such audit reveals that you have underpaid HME by an amount greater than five percent (5%) 
of the amounts due HME in the period being audited, or that you have knowingly breached any material 
obligation hereunder, then, in addition to such other remedies as HME may have, you shall pay or reimburse 
to HME the cost of the audit. 
 
11) U.S. GOVERNMENT RESTRICTED RIGHTS.   The Software and accompanying documentation are 
deemed to be "commercial computer software" and "commercial computer software documentation," 
respectively, pursuant to DFAR Section 227.7202 and FAR Section 12.212, as applicable.  Any use, 
modification, reproduction, release, performance, display or disclosure of the software and accompanying 
documentation by the U.S. Government shall be governed solely by the terms of this Agreement and shall be 
prohibited except to the extent expressly permitted by the terms of this Agreement. 
You must affix the following legend to each copy of the Software: 
Use, duplication, reproduction, or transfer of this commercial Software and accompanying documentation is 
restricted in accordance with FAR 12.212 and DFARS 227.7202 and by a license agreement.   
Contact HM Electronics, Inc., 14110 Stowe Drive, Poway, California, 92064 U.S.A. 
 
HME DISCLAIMS ANY REPRESENTATION OR WARRANTY MADE BY ANY DISTRIBUTOR, RESELLER 
OR DEALER TO YOU WHETHER EXPRESS OR IMPLIED. 
 
Should you have any questions concerning this AGREEMENT, or if you desire to contact HME for any 
reason, please contact us: HM Electronics, Inc., 14110 Stowe Drive, Poway, California, 92064, U.S.A. 
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1.1 PC30A DESCRIPTION 
PC30A is a PC application which provides you, the user of System 30 Timers, with convenient 
and powerful data control and reporting capabilities.  You are a typical user of PC30A if you are 
a Store Manager, a Franchise Store Owner, or a Corporation seeking to manage one or more 
stores based on data provided by the System 30 Timer and reported by PC30A.   
 
PC30A allows you to analyze performance in one or more stores to determine what 
management action can be taken to optimize store operations.   
 
! PC30A is a database application able to acquire large amounts of data from individual 

System 30 Timers and store it in a central Personal Computer. 
! PC30A can generate reports summarizing the data in printed or computer file format.   
! PC30A provides you the ability to manually connect to particular store timers and acquire 

timer-generated reports.   
! PC30A is also an automatic scheduler that can poll for data from one or more store timers 

and create database-reports within a configurable and flexible time period. 
! PC30A is a settings editor, giving you the ability to remotely view and change store timer 

settings. 
! PC30A allows you to connect to local timers via a direct serial connection or remote timers 

via a network (TCP/IP) or a modem connection. 
 
These instructions provide information necessary for installation and initial setup of the PC30A 
program.    
 
 
 

    SECTION 1.     INTRODUCTION 

 
Minimum Requirements for Use of PC30A Software 

• IBM compatible PC with a PentiumTM microprocessor 
• Minimum of 32 megabytes RAM 
• Minimum of 100 megabytes available hard disk space 
• One available Ethernet port, a modem interface or an RS-232 serial port 
• Serial interface cable or CAT 5e Network cable appropriate for your PC (See Section 2.1) 
• System 30 Timer with firmware version A.2.1* or later 
• Microsoft WindowsTM 95, WindowsTM 98, WindowsTM NT4.0 Service Pack 3 or later,  

WindowsTM 2000, WindowsTM  XP or WindowsTM  ME  
• Internet Explorer 4.1 or higher 
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1.2 PC30A BASICS 
PC30A is a system for data collection, archiving and reporting from one or more System 30 
Timers.  It is a database application designed to help you keep track of trends and activities in 
the store’s drive-thru lanes and to make decisions about store operations. 
 
Once installed, PC30A acts as the central data organizer.  You can program PC30A to 
call/connect to one or more store timers and collect their Raw Car Data (RCD) on a scheduled 
basis.  You can also manually collect RCD by connecting PC30A to any store you have entered 
into its store list.  The RCD collected by PC30A will be added to the active database, which can 
grow to a maximum of 980 megabytes of stored data.   

 

 
Figure 1.    Typical PC30A equipment configuration 

 
 
You can also use PC30A to obtain printed reports from the connected store timer, formatted 
exactly as they would be printed at the timer’s printer.  After RCD has been collected from a 
store, you can request reports to be printed or saved to file for specific dates and times, or on a 
scheduled basis.  PC30A provides a large number of reporting functions, including predefined 
summary reports of drive-thru performance.  
 
The PC30A can also be used to view and modify store timer settings, thus controlling how the 
timer is set up, as if you were viewing the timer menus.   
 
The PC30A can be used to monitor individual cars as they leave the store’s drive-thru lanes. 
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1.3 PC30A FEATURES 
The PC30A application provides the following major features listed below. 

1.3.1 What PC30A Can Do 
! Connect to one or more remote HME System 30 Timer (via Network, using TCP/IP). 
! Connect to only one local HME System 30 Timer (via serial port). 
! Connect to one or more remote HME System 30 Timer (via modem). 
! Store large amounts of car data on a scheduled and on-demand basis for one  

or more store timers. 
! Acquire Timer-Generated Summary Reports from manually connected timers. 
! Generate Scheduled or On-Demand Summary Reports from the Database of Raw Car Data 

that it has collected. 
! Can generate customized Summary Reports from the database including Inactivity, Excess 

Time and Comparison Summary Reports. 
! Can acquire Timer-Generated Settings Reports that allow you to see how a given timer is 

configured. 
! Can generate Database-Derived Settings Reports. 
! Can create scheduled Database-Derived Summary Reports for various periods of time. 
! Can change/display settings for remote or local store timers. 
! Can monitor drive-thru activity as cars pass through the lane. 
 
Use the Getting Started section for instructions on how to start using these features. 

1.3.2 What PC30A Does Not Do 
PC30A does not generate graphs of summary data; however, it provides Raw Car Data and 
System 30 Timer Settings in a generic data format that can be used by other software to 
produce graphs. 

1.4 TECHNICAL SUPPORT 
For authorization to use this product, or for technical assistance, call HME Customer Support at 
1-800-848-4468 or Fax 858-552-0172 (Attn: Customer Support).  
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2.1 CONNECTION TYPES 
The cables mentioned below can be obtained from a computer hardware dealer or can be 
ordered by calling the HME Sales Department at (858) 535-6060.  HME cables are available 
in 10 ft. (3.05 meter) and 100 ft. (30.48 meter) lengths. 

2.1.1 Network (Ethernet) Cable Connections for a Network-enabled 
System 30 Timer 
Depending on your local network configuration, connect the network-enabled System 30 
Timer to your network according to one of the following examples.   

1. Direct Network Connection 
If you do not have any connections to your computer’s network connector, you can 
connect the computer directly to the network-enabled System 30 Timer using a 
cross- over Ethernet cable as shown in Figure 2. 
 

 
Figure 2.    Computer connected directly to a network-enabled System 30 Timer 

 

2. Indirect Network Connection 
If you already have a connection between your computer’s network connector and 
other network devices, such as a hub/switch or router, you can connect the 
network-enabled System 30 Timer to the same hub/switch or router using a 
standard straight-through Ethernet cable as shown in Figure 3. 

 
Figure 3.    Computer connected via hub/switch or router to a network-enabled System 30 Timer 

    SECTION 2.     INSTALLATION 
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2.1.2 Direct Serial Cable Connection 
An RS-232 serial interface cable can be used to connect the computer (PC) to a System 30 
Timer.  It must have a standard 9-pin female "D" connector at the timer end, and a 9-pin or 
25-pin female "D" connector at the computer’s end (depending on whether a 9-pin or 25-pin 
serial input connector is available on your PC). 
 
! It must be shielded to prevent interference. 
! Maximum cable length should not exceed 150 ft. (45.72 meters) for reliable communication. 
! It must be a crossover (null modem) cable (See diagram below). 
! Pin connections for the cable wires must be as shown in Figure 4. 
 

 
Figure 4.    RS-232 cable pin connections (PC to a System 30 Timer) 
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Connect the cable directly from the computer to the timer unit as follows.  Refer to Figure 5. 
! Plug the 9-pin female connector on the interface cable into the connector on the bottom of 

the System 30 Timer.  Tighten the screws to secure the connector to the unit. 
! Plug the female 9-pin or 25-pin connector on the other end of the interface cable into the 

serial port connector on the back of the PC.   
 
NOTE:  Be certain you have the correct interface cable for your PC.  Some PC's have either 
two 25-pin connectors or two 9-pin connectors, and some have one of each. 
 
 
 

 
Figure 5.    PC to System 30 Timer Direct Serial cable connections 
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2.1.3 Remote Modem Cable Connections from a Computer to an 
External Modem 
If an external modem is used, an RS-232 serial interface cable must be used to connect the 
computer (PC) to the modem.  It must have a standard 9-pin female "D" connector at the 
computer end, and a 25-pin male "D" connector at the modem end. 
 
! It must be shielded to prevent interference. 
! Maximum cable length should not exceed 150 ft. (45.72 meters) for reliable communication. 
! It must be a straight-thru serial cable. 
! Pin connections for the cable wires must be as shown in Figure 6. 
 
 

 
Figure 6.    RS-232 cable pin connections (PC to external modem) 
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If an external modem will be used, connect the cable directly from the computer to 
the modem as follows.  Refer to the top part of Figure 7. 
 
! Plug the 25-pin male connector on the interface cable into the connector on the 

modem.  Tighten the screws to secure the connector to the unit. 
! Plug the female 9-pin or 25-pin connector on the other end of the interface 

cable into the serial port connector on the back of the PC.   
NOTE:  Be certain you have the correct interface cable for your PC.  Some PC's 
have two 25-pin connectors or two 9-pin connectors, and some have one of each. 
! Connect the standard telephone cables to the modem as shown in the top part 

of Figure 7. 

 
Figure 7.    PC and external modem cable connections 

 
 

If the computer has an internal modem, connect the standard telephone cables 
directly to the computer as shown in the bottom part of Figure 7. 
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2.1.4 Remote Modem Connection from a System 30 Timer to 
an External Modem 
An RS-232 serial interface cable must be used to connect the System 30 Timer to 
the modem.  It must have a standard 9-pin female "D" connector at the timer end, 
and a 25-pin male "D" connector at the modem end, as shown in Figure 8. 
 
! It must be shielded to prevent interference. 
! Maximum cable length should not exceed 150 ft. (45.72 meters) for reliable 

communication. 
! It must be a straight-thru modem cable. 
! Pin connections for the cable wires must be as shown in Figure 8. 
 

 
Figure 8.    RS-232 cable pin connections (System 30 Timer to an External Modem) 

 
Connect the System 30 Timer to the modem as shown in Figure 9.  Note the two 
different configuration possibilities, depending on whether or not the optional 
ComSwitch will be used. 
NOTE:  If the telephone handset is picked up while the modem is in use, the 
connection will fail.  HME therefore provides an optional ComSwitch, which allows 
the phone line from the wall jack to be shared between the telephone and the 
modem so they do not interfere with each other.  If you pick up the telephone 
handset to make a call while the modem is in use, you will get a busy signal.  
Figure 9 and 10 show how to connect the ComSwitch to the modem, telephone 
and line from the wall jack. 
 
If the optional ComSwitch will not be used, connect the cables as follows.  Refer 
to Figure 9. 
! Plug the 9-pin female connector on one end of the interface cable into the 

connector on the bottom of the System 30 Timer, and plug the 25-pin male 
connector on the other end of the cable into the connector on the modem.  
Tighten the screws to secure the connectors to the units. 

! Connect a standard telephone cable from a telephone to the modem, and 
another from the modem to a telephone wall jack. 
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Figure 9.    Not using the optional ComSwitch  

 
 

                   
Figure 10.    Using the optional ComSwitch 

 
If the optional ComSwitch will be used, connect the cables as follows.  Refer to 
Figure 10. 
! Plug the 9-pin female connector on one end of the interface cable into the 

connector on the bottom of the System 30 Timer, and plug the 25-pin male 
connector on the other end of the cable into the connector on the modem.  
Tighten the screws to secure the connectors to the units. 

! Connect a standard telephone cable from a modem to the ComSwitch 
Fax/Modem input, and another from the ComSwitch Line In input to a telephone 
wall jack. 

! Connect a standard telephone cable from a telephone to the ComSwitch  
phone input. 
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2.1.5 Recommended External Modems to Connect to a 
System 30 Timer 
The only external modems recommended for connection to the System 30 Timer 
are the US Robotics Sportster 14400,  28800,  33600 or 56K Faxmodems. If any 
other modem is used, be certain it is Hayes-compatible and meets the 
requirements below. 
All modems connected to the System 30 Timer must be able to permanently save 
the following parameters (via DIP switches or nonvolatile memory), so they are 
retained after the modem is powered down: 
! Auto Answer Only Mode 
! Transmit and Receive at 9600 Baud only 
! No Parity 
! 8 data bits                    
! 1 stop bit 
! Hardware (RTS/CTS) Handshake 
! Local Echo off         

2.1.6 Recommended Modems to use with the Computer 
The following internal/external modems are recommended for use with the 
Computer (PC) that will attempt to make a Remote Modem connection with a 
System 30 Timer. If a modem other than those listed below is used, be certain it is 
Hayes-compatible.  
! US Robotics Sportster 56K Faxmodem 
! US Robotics Sportster 28,800 Faxmodem 
! US Robotics Sportster 33,600 Faxmodem 
! Aspen 14,400 Data Fax Modem 
! Megahertz XJ1144/XJ2144 (14, 400 Modem) 
 
All modems connected to the PC must meet the following standards/settings: 
! Transmit and Receive at a minimum of 9600 Baud  
! No Parity 
! 8 data bits  
! 1 stop bit  
! Hardware (RTS/CTS) Handshake 

2.1.7 Optional ComSwitch Installation and Operation 
Refer to the ComSwitch Operator=s Guide for further instructions on how to install, 
operate and maintain the ComSwitch product.  After you install the ComSwitch, 
you MUST reset the switch with the following procedure: 
! Take the phone off the PHONE port off-hook. 
! Press # t999(three beeps will be heard)t. 
! Hang up the phone. 
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2.2 PC30A SOFTWARE INSTALLATION 
 
NOTE:  Before installing PC30A, close all other software that is open. 
 
To install PC30A under WindowsJ 95, WindowsJ 98, WindowsJ NT4.0 Service 
Pack 3, WindowsJ 2000/XP or WindowsJ ME, follow the instructions below.  
 
 
 
 
 
 
 
 
1. Insert the CD into a selected CD-ROM drive.   

! If the CD-ROM drive is set for AutoPlay, the PC30A installation will 
begin automatically and the screen below will appear.   
Skip steps 2 and 3. 

! If the CD-ROM drive is not set for AutoPlay, continue with the 
following steps. 

 
2. Under Windows Explorer or File Manager, double click on the CD-ROM  
drive where the CD is inserted. 
 
3. Double click on the setup.exe file, and the screen below will appear. 
 

 
 
4. Select Next> to continue. 
 

To install PC30A for Windows NT/2000/XP, you must be a System Administrator.    For 
Windows NT/2000/XP, if you have installed this product for multiple users, you may give 
authorization to all PC30A users at once.  To do this, log into the computer as System 
Administrator and install PC30A according to these instructions.  After successful 
installation, all users will have access to PC30A.  To be able to run PC30A, each user 
must have “Read, Write and Execute” permission for the ProgramFiles\HME\PC30A 
directory. 
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5. Please read all of the license agreement carefully. 
 

! If you do not agree to comply with the license agreement, select I 
do not accept . . . , and the PC30A software installation will stop. 

! If the license agreement is acceptable, select I accept . . . , then 
select Next>. 

 

 
 
Enter the appropriate information under User Name and Organization,  
and select Next>. 
 
NOTE:  For Windows NT/2000/XP, you will also have the following selections. 
 
Install this application for: 

! Anyone who uses this computer (all users) 
! Only for me (user’s name) 
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To change the destination folder where PC30A software files will be installed on 
your computer, select the Change button to assign a different location, then select 
Next>. 
 

 
 
8. Select Manual Startup or Auto Startup, then select Next>. 
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9. Read the information on the screen.  If the Folder shown is acceptable,  
select Install. 
 

 
 
10. Please wait while PC30A software is installed.  If you would like to stop the  
installation at any time, select Cancel. 
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11. Your PC30A software installation has been completed.  Select Finish to  
close the Installation Wizard. 
 
 
 
 
To uninstall PC30A anytime: 
 
To uninstall PC30A software from your computer, complete the steps below. 
 

! Double click on the My Computer icon  on your main computer screen. 

! Double click on the Control Panel icon . 

! Double click on the Add/Remove Programs icon . 
 

! Select PC30A and click on the Add/Remove bar. 
 

! Select Yes to the question “Are you sure you want to uninstall this product.” 
 

! Select OK.  
 

! When the PC30A software removal has finished, restart the computer. 
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3.1 STARTING PC30A 
From the Desktop (or from Start->Programs->HME->PC30A), click on the PC30A 
shortcut to start the PC30A Application. 

3.2 AUTHORIZING PC30A 
When the following screen comes up, call HME Customer Support at  
1-800-848-4468 for an authorization code. 
 

 
 
Please have the Serial Number of the PC30A (attached to the envelope containing 
the PC30A CD) ready when you call HME Customer Service. 

    SECTION 3.     OPERATION 
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3.3 RUNNING PC30A FOR THE FIRST TIME 
After you successfully authorize PC30A, it will start running and performing 
initialization of the Raw Car Data database.  You will see the following screen: 
 

 
 
You will then see the following status on the screen, indicating a new database is 
being created.  This status will no longer appear the next time you run PC30A. 
 

 
 
Finally, you will see a dialog box indicating that PC30A is searching for valid direct 
serial Com and modem ports.  PC30A will attempt to automatically assign the first 
direct serial Com and modem port it finds for use in connecting to store timers.  
Please note that Network connections to network-enabled System 30 Timers do 
not use these ports. 
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NOTE:  PC30A may take several minutes to search for Modem and  
             Com Ports. 
 
In the rare case that the PC30A database has been deleted and the database 
backup is missing, the following screen will be displayed to inform you that PC30A 
can no longer run. 
 

 
 



 20 

3.4 UNDERSTANDING THE MAIN SCREEN 
The PC30A main screen appears after the PC30A Interface Program has been 
opened and has initialized the database.  The main screen has various controls 
that allow you to perform all PC30A operations by accessing its functions and 
features including menus, task bar buttons, a report viewer, a report control bar,  
a status line and an error line. 
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3.5 GETTING STARTED 
When starting PC30A for the first time, it is important to understand basic PC30A 
operations by completing the steps below.  These steps cover basic functions that 
you should practice and become familiar with before attempting more advanced 
operations. 
 
! The First Time you run PC30A – PC30A authorization  (Pages 18 - 20) 
! Learn the Menu Bar – become acquainted with the menu system  

(Pages 23 - 28) 
! Edit Options – change settings for Raw Car Data (RCD) scheduling and 

direct serial Com and modem ports (Pages 30 – 34) 
! Add store(s) – add a new store to a list of stores in the database (Page 35) 
! Connect store – connect to a store timer from the list of stores (Pages 50 - 51) 
! Get On-Demand Reports – print/view summary and settings reports from 

store timer and database (Pages 56 – 71) 
! Disconnect from store – disconnect from a connected store (Page 52) 
! Schedule report types and times – select summary reports to be printed 

and/or saved to file on a timed basis (Pages 72 – 79) 
 
New Features Shortcuts 
 
Here are some additional “getting started” steps that will allow you to explore new 
features provided by this version of PC30A. 
 
! Viewing and editing settings – learn how to change System 30 Timer 

settings remotely (Pages 41 - 48) 
! Monitoring car activity at a store timer – learn how to connect to a store timer 

and view the operation of the store’s drive-thru lane (Pages 54 – 55) 
! Getting customized reports – learn how to obtain elaborate reports that 

provide you with statistics about how your store is performing, including 
excess time, inactivity, and on-demand comparison summary (Pages 67 – 68) 

! Editing comparison summary reports schedule – learn how to set up the 
scheduling of the powerful comparison summary report.  This report allows 
you to see how multiple stores are performing in a side-by-side comparison 
(Pages 39 – 40) 
 

NOTE:  All date and time controls may look different if the country locale is not 
English (United States). You can customize their appearance by going to Control 
Panel/Regional Settings. Time and Date Tabs have pull-down menus. 
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3.6 USING THE MENUS 
All of the features of PC30A can be accessed from the Menu Bar.  The Menu Bar 
contains major categories of PC30A operations from which you can access pull 
down menus, containing specific functions.  The Menu Bar shown below appears 
near the top, left corner of the PC30A main screen. 
 

 
 
To view drop-down menus from the Menu Bar:  
! Place your cursor on any menu-bar item (such as File, Edit, View, etc.) and click 

for its drop-down menu to appear, or… 
! Hold down the Alt button on your keyboard and press the key of the letter that 

is underlined on the desired menu-bar item. 
 

3.6.1 File Menu 
The File menu is used for operations involving PC30A database, timer settings  
and reports.  The menu gives choices to Create an Archive of the database,  
to Compact and Repair the database, and to Export Raw Car Data from the 
database to a text file or Import a raw car data text file into the database.   
In addition, the File menu is used to Print and Export the timer reports, and to 
Exit PC30A. 
 
Select File on the Menu Bar to view the drop-down File menu. 
 

 
 
! Select Active Database on the File menu to view the Create Archive and 

Compact and Repair dialog box. 
! Select Raw Car Data on the File menu to view the Import from text file and 

Export to text file dialog box. 
! Select Reports on the File menu to view the Export and Print dialog box. 
! Select Exit on the File menu to close/exit the PC30A software program. 
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Archiving and Compacting Active Database Files 
 
See PC30A Advanced Topics: Maintaining your Database. 
 
Importing and Exporting Raw Car Data 
 
The PC30A is able to import RCD from two sources: 
1. Store Timers 
2. Text Files  
 
PC30A Basics (Page 2) describes how the PC30A collects data from 
Store Timers.  Another approach is discussed in PC30A Advanced 
Topics:  Configuring PC30A for Distributed Use (Page 81), for collecting 
RCD from multiple groupings of stores without having to collect the data 
directly from each store. 
PC30A is also able to export RCD to a Tab or Comma-delimited text file 
for use in 3rd party applications such as spreadsheets, etc. 
 
Raw Car Data 
 
The Raw Car Data menu opens another menu with 2 choices: 
 
 

! Import from text file …  
! Export to text file …   

 
 
 
 
 
 
 
Import from text file … 
 
The Import from text file… menu opens the Import RCD Text File 
into Active Database dialog box, which is used to import the Raw Car 
Data text delimited files and settings files into the PC30A Database.  
This feature is used for the PC30A configurations in which data can be 
collected from several timers by more than one PC30A, then manually 
imported to one central PC30A’s Database.   
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The Import RCD Text File into Active Database dialog box is used to 
select a store, from which the Raw Car Data will be imported, and the Raw 
Car Data text file to be imported.  PC30A will import Raw Car Data and 
save it under the Store ID that is found in the text file.  If the Store ID does 
not already exist in the Database, these records will not appear in any 
reports, even though they have been imported.  Each Store ID in the Store 
List must match the Store IDs of the timer where Raw Car Data is being 
acquired.  PC30A will import only those Raw Car Data records that match 
the store ID selected on the grid.  PC30A will not import records, that 
already exist in the database. 
 
The Stores grid in the dialog box is used to select the store for which the 
Raw Car Data will be imported.  The store can be selected with a mouse 
click on the row containing the store, or using Up/Down keys of the keypad. 
 
The Select File button is used to select the text file to be imported.  
Selecting the Select File button opens a standard windows File Open 
dialog box, which allows selecting the directory and the file name of the 
Raw Car Data text file.  After the file has been selected, a path and file 
name are displayed above the Status Bar. 
 
The Import button is used to start the import process.  Selecting the Import 
button will activate the Progress Bar at the bottom of the dialog box.  The 
Progress Bar indicates the PC30A is busy importing data, but does not 
show the overall percentage of the completed task.   
 
After the entire file has been read and appropriate data records have been 
imported, the number of records imported will be shown above the Status Bar. 
 
The Close button is used to close the dialog box.  Selecting the Close 
button will abort any import in progress.  
 
NOTE:  In the PC30A Database, a unique Raw Car Data record is defined 
by Store ID, lane number of the event, and event time. 
 
NOTE:  each unique RCD record imported into the Active Database is 
inserted in sorted order. 

Export to text file … 
The Export to text file… menu opens the Export RCD into Text File 
dialog box, which allows you to export the Raw Car Data into text-delimited 
file.  This feature is used for the PC30A configurations in which different 
PC30A installations share data.  
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The Export RCD into Text File dialog box is used to select a store, whose Raw 
Car Data will be exported.  PC30A will export only those Raw Car Data records 
that match the Store ID selected on the grid, and that lie within the Start - Stop 
range selected on the dialog box. 
 
NOTE:  For PC30As used in a Distributed Configuration, settings files must be 
transferred together with the exported file.  Without the settings files, PC30As 
will not be able to import Raw Car Data text files. 
 
The Stores grid shows the Store ID, Store Name and the type of Connection 
to that store’s timer.  The store whose Raw Car Data will be exported can be 
selected with a mouse click on the row of the grid containing that store, or by 
using the up and down arrow keys of the keypad. 
 
The Date and Time settings are used to limit the time range of the Raw Car 
Data to be exported.  Changing the Start or Stop dates and times will affect 
how many records are exported to the text file. 
 
The Tab and Comma selections in the dialog box allow you to select the text file 
format. Selecting Tab will format the Raw Car Data text file with columns separated 
by tabs, whereas selecting Comma will separate the data columns with commas. 
 
The Select File button is used select the text file to be exported.  The Select File 
button opens a standard windows File Save dialog box, which allows selecting the 
directory and the file name of the Raw Car Data text file.  After the file has been 
selected, a path and file name will be displayed above the Status Bar. 
 
By pressing the Export button, you can start the export process.  The Export 
button will activate the Progress Bar at the bottom of the dialog box.  The 
Progress Bar indicates the PC30A is busy exporting data, but does not show 
the overall percentage of the completed task.   
 
After the entire file has been written and appropriate records have been 
exported, the dialog box will show the number of records exported above the 
Status Bar. 
 
The Close button is used to close the dialog box.  Selecting the Close 
button will abort any export in progress. 
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Exporting and Printing Report Files 
 
Once you create a Summary or Settings report, PC30A gives you the 
ability to save the report into alternative data file formats.  In addition, 
you can print reports to a default printer exactly as they are displayed in 
the report viewer. 
 
Reports 
 
The Reports menu opens another menu with the following two choices, 
which deal with reports currently displayed on the screen. 
 

  Export… 
  Print … 

  
 
 
 
 
 
 
 
 
Export … 
 
The Export menu opens the Export dialog box, used to export the 
report currently displayed on the screen into a file that can be opened 
with another software application, such as a word processor to create a 
document or a spreadsheet application to graph the data. 
 

 
  
The Export dialog box can export to various formats: 
 

Adobe Acrobat 
Character Separated Values 
Tab Separated Values 
Crystal Reports 
Data Interchange Format 
Excel   
HTML 
Lotus 
Paginated Text 
Record Style (Columns of values) 
Rich Text Format 
Tab Separated Text 
Tab Separated Values 
Text 
Word for Windows 

 
 



 27 

The Print menu opens the standard windows Print dialog box, used to 
print the report currently displayed on the screen to a default printer.  
The Print dialog box offers various options for printing a report. 
 

 
 
The Print Range section of the Print dialog box is used to select which 
pages will be printed.  Selecting All will print the entire report, where as 
selecting Pages and specifying From and To will print only the selected 
pages. 
 
! Click on the up or down arrow at the right of the Copies box to 

select the number of copies of the report to print. 
! Select the Collate Copies checkbox to collate multiple copies of the 

printed report. 
! Select OK to start printing the report. 
! Select Cancel to close the dialog box without printing the report. 
 
NOTE:  PC30A does not provide a dialog box to set up the printer.  
PC30A will print to a default printer using default page setup. 
 
Exiting PC30A 
 
The Exit menu is used to close the PC30A. 
 
NOTE:   Exiting PC30A stops the RCD scheduler (if enabled) from 
collecting Raw Car Data and the stops the reports scheduler (if enabled) 
from generating reports until PC30A is resumed at a later time. 
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3.6.2 Edit Menu 
The Edit menu enables you to edit options, which control the overall PC30A 
operation, including which com ports are used if you select to connect to the Timer 
using serial communications, car data acquisition, etc.  You can also add, edit and 
remove store entries from the list of store timers to acquire data.  You can 
schedule reports of various types such as daypart, shift, day and week, from the 
active database.  You can also edit timer settings for a connected timer or offline to 
a file. 
 
Select Edit on the menu bar to view the drop-down Edit menu. 
 

 
 
! Select Options on the Edit menu to view the Edit Options dialog box. 
! Select Stores on the Edit menu to view the Edit Stores dialog box. 
! Select Reports Schedule on the Edit menu to view the Edit Reports Schedule 

for Stores dialog box. 
! Select Comparison Schedule on the Edit menu to view the Comparison 

Scheduler dialog box.  
! Select Edit Settings on the Edit menu to view the Edit Settings dialog box. 
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Editing Options 
 
Select Edit from the menu bar and select Options from the drop-down menu.   
 
The Edit Options dialog box will appear.    
 
Select each of the tabs in the Edit Options dialog box, and edit the 
information in each of the selections as follows. 
 
RCD Acquisition 
 

 
 
The RCD Acquisition option allows you to set up how often the Raw 
Car Data is collected from the list of stores.   
 
! To choose the day of the week in which RCD will be collected, click 

on the arrow to the right of the RCD Acquisition Align Day box and 
make a selection.   Selecting Every Day allows RCD to be collected 
once a day at the specified Align Time.  Selecting Multi-Periods 
Per Day allows RCD to be collected at multiple intervals within each 
day. 

! To choose the time of day at which RCD will be collected, click on 
the up or down arrows to the right of the RCD Acquisition Align 
Time box and make a selection.  If Multi-Periods Per Day was 
selected in the RCD Acquisition Align Day box, the time entered in 
this box will act as a reference time, at which time intervals begin.   

! The RCD Acquisition Period selection is only available when the 
RCD Acquisition Align Day selection is Multi-Periods Per Day.  
This selection determines the intervals at which RCD will be 
collected within each day.  It is shown in hours and minutes 
(hh:mm), such as 01:00 for every hour. 

 
In the example shown above, Raw Car Data is collected each day, 
beginning midnight, every three hours. 
 
! Select Update to save your settings, or… 
! Select Close to close the dialog box and ignore editions. 
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Com Ports 
 
Note:  If you are going to use a Network connection to a network-
enabled System 30 Timer, then you can skip this section. 
 

 
 
After the Com Ports tab is selected, a PLEASE WAIT: Testing Com Ports 
dialog box will appear, and will remain on the screen until the Modem Com 
Ports and the Direct Serial Com Ports are finished testing, then the dialog 
box shown above will appear, showing the detected com ports. 
 
The Com Ports option must be set to show which PC Serial Com Ports 
are used for communication with local and remote modem connected 
store timers.   The Direct Serial Com Port connects to a local store 
timer directly from your PC and the Modem Com Port connects to a 
remote store timer via modem (either internal or external) from your PC.   
 
Click on the arrow at the right of the two Com Port boxes to choose 
settings from the list of modem ports that were detected. 
 
NOTE:  If no Direct Serial or Modem Com Ports were detected, a 
warning will appear telling you to make sure your PC’s Com ports are 
functioning properly. 
 
When you are finished selecting the appropriate Com Ports: 
 
! Select Update to save your settings, or… 
! Select Close to close the dialog box and ignore editions. 
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Report Options 
 

 
 
Reports Options allows you to select how the Report Time Format will 
appear on Summary reports, etc.  You can choose either Min:Sec 
format to show mm:ss, or Sec Only format to show sss for time periods 
printed on all reports. 
 
When you are finished selecting the Report Time Format: 
 
! Select Update to save your settings, or… 
! Select Close to close the dialog box and ignore editions. 
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File Size 
 

 
 
The File Size option allows you to set up the maximum size of three 
types of files to be collected. 
 
! Click on the up or down arrow to the right of the Max Transfer RCD 

File Size box to select a limit to the number of records (cumulative) 
that can be collected from a store timer in a temporary file to be 
used for distributed configuration of PC30As.  (The PC30A stores 
collected RCD in its database, and also in a transfer file to be 
imported into another PC30A application.  See Configuring PC30A 
for Distributed Use.) 

! Click on the up or down arrow to the right of the Max Log File Size 
box to select a limit to the number of entries that can be recorded in 
the log file.  PC30A records connection and report activity in a log 
file for review in the event of problems with connecting to store 
timers, acquiring reports, etc.  If the file grows to the selected size, 
the oldest entries will be dropped as new entries are logged. 

! Click on the up or down arrow to the right of the Max Years In 
Database box to select the number of years worth of RCD records 
stored in the active database for each store timer.  Data is deleted 
on a rolling cutoff basis.  For example; if 5 years is selected, every 
day, the data stored in excess of 5 years prior to the current date 
will be deleted from the database. 
 

When you are finished selecting the File Size: 
 
! Select Update to save your settings, or… 
! Select Close to close the dialog box and ignore editions. 
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RCD Acquisition Recovery 
 

 
 
The RCD Acquisition Recovery option allows you to control the 
number of times and how often PC30A will attempt to connect to a 
remote store timer to collect Raw Car Data when a scheduled RCD 
Acquisition attempt fails. 
 
! Click on the up or down arrow to the right of the Maximum Retries 

box to select the number of times the PC30A will retry to get Raw 
Car Data.   

! Click on the up or down arrow to the right of the Retry Interval box 
to select the amount of time the PC30A will wait between retry 
attempts.   
 

NOTE:  If a retry session has begun (store retry count is not ZERO) and 
you select a lower value for Maximum Retries, the store’s retry count will 
be adjusted to a lower value during the next failed retry.  (e.g.  Store X 
failed to get RCD, and its retry count is now 5.  Then Maximum Retries is 
set to 2.  During the next retry attempt Store X fails to get the RCD again, 
and its retry count is adjusted to the new Maximum Retries, which is 2.)  
However, if a user selects higher number of retries than current retry 
count, the store will continue to decrement it’s original retry count until 
all retries are exhausted. 
 
NOTE:  If a scheduled RCD acquisition occurs during a period of 
ongoing retries, the retries will be cleared. 
 
When you are finished setting the RCD Acquisition Recovery times: 
 
! Select Update to save your settings, or… 
! Select Close to close the dialog box and ignore editions. 
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Editing Stores 
 
Select Stores from the drop-down Edit menu, or… 

Click on the Edit Stores toolbar button .  
 
The Edit Stores dialog box will appear. 
 
The Edit Stores dialog box provides an opportunity to view connection 
details for all stores and timers in the list of stores to which the PC30A 
can connect.  It will also allow you to modify, add and delete store 
information. 
 

 
 
To view each store currently entered for connection to PC30A, use the 
left or right arrow buttons near the bottom of the Edit Stores dialog box 
to move one-by-one through store records, or use the left or right arrow 
buttons to go to the beginning or end of the list of store records. 
 
To add a new store to the list of stores, select the Add button to enter 
Store Information and Store Connection Options. 
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Store Information 
 
! Store ID:  Required.     Must match store ID of timer to be 

connected.  If necessary, check System 30 Timer setup using the 
Timer menus to determine the Store ID. 

! Name:  Optional.    Name of the store. 
! Street:  Optional.     Location of store. 
! City:  Optional.     Location of store. 
! State:  Optional.     Location of store. 
! Zip:  Optional.     Location of store. 
! Get Scheduled RCD  :  Check this box if you want to schedule 

importing of RCD from this store timer. 
! Get Schedule Settings  :   Check this box if you want to schedule 

importing of store timer settings (used to interpret the RCD for 
reports) each time RCD is imported.  This information can be used 
to verify that all settings match the timer settings. 
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Store Connection Options 
 
! Connection:   Required.     Choose NETWORK if this is a listing for 

a remote store timer that connects to PC30A using LAN or WAN 
(Local or Wide Network connection).  Choose MODEM if this is a 
listing for a remote store timer that connects to PC30A through a 
modem.  Choose DIRECT if this is a listing for the local store timer 
that is directly connected to your PC through a serial cable.  

! Phone #:  Required for modem connections. 
! Note:  If you are calling from an office that requires dialing a number 

such as 9 for an outside line, in the Phone Number listing, you must 
add the number followed by a comma, followed by the actual 
number. 
Example:  If the number is 867-5309, enter 9,867-5309 

! Note:  If you are calling from a Store that has a ComSwitch on the 
phone line, and the call is not long distance, you must add 
,#11,#11,#11 to the end of the phone number. 
Example:  If the number is 867-5309, enter 867-5309,#11,#11,#11 

! Note:  If you are calling from a Store that has a ComSwitch on the 
phone line, and the call is long distance, you must add 
,,,#11,#11,#11 to the end of the phone number. 
Example: If the number is 1-505-867-5309, enter 1-505-867-

5309,,,#11,#11,#11 
! Modem String:   Required for modem connections.  The default 

modem string is AT&F0E0HQ0V1X0&K0&B1&H1&M4.  The modem 
used must comply with the string, which is composed of the 
following commands:   
E0    = Echo off 
Q0    = Display result codes 
V1      =   Enable verbal codes 
X0     =   Basic result code set (OK connect, ring, no carrier error) 
&K0  =    Compression is turned off 
&B1  = Ensure the modem baud rate remains fixed during 
     modem negotiation 
Please consult your modem manual to be sure you comply with the 
intent of these settings if you change this modem string to support 
your modem. 
NOTE:  For US Robotics and 3COM modems, it is recommended to 
add &B1 to the modem initialization string for each store, which uses 
MODEM connection.  The &B1 command ensures the modem’s 
serial port rate does not change based on connection, but stays 
fixed.  For non-USRobotics modems, remove &B1 from the modem 
string and consult your modem manual for an equivalent option. 
NOTE:  For more reliable serial communication, Normal/ARQ Error 
control should be enabled if possible (for US Robotics & 3COM 
modems, this setting is &M4 in the initialization string). 

! Baud:  Required for serial or modem connections.   If you are 
using a modem connection, use the down arrow to the right of the 
Baud box to set any baud that is supported by your modem.  If you 
are using a direct serial connection, this setting MUST match the 
baud setting of the System 30 Timer, 9600, 19200 or 38400 (Timer 
Default).  Refer to the System 30 Timer Operating Instructions and 
check the timer settings to find out which baud setting is used. 
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! Wait Time:  Required for modem and Network (TCP/IP) connections.    
Use the up and down arrows to the right of the Wait Time box to set the 
amount of time the PC30A will wait for a modem connection to be 
made. For NETWORK connection this setting sets delay duration 
between attempts to establish IP session. 

! IP Address:  Required for Network (TCP/IP) connections.  Used 
to identify the IP Address of the Network-enabled Sys30A Timer. 

! IP Port:  Required for Network (TCP/IP) connections.  Used to 
identify the IP Port of the Network-enabled Sys30A Timer. 

 
 
Other Store Edit Controls 
 
! The Default button is used to default settings while you are adding 

or editing a store. 
! The Refresh button is used to refresh/update the database with the 

latest store options editions. 
! The Delete button is used to remove a store from the list.   

NOTE:  If you desire to change a store ID, you must delete the store 
and use the Add button to create a new store entry with the correct 
store ID.  This will cause the stores Raw Car Data to be lost.  You 
can archive the store’s data; see Archiving and Compacting 
Active Database Files. 

! The Edit button is used to change settings of the store currently 
shown in the Edit Stores dialog box. 
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Editing Reports Schedule 
 
This dialog box provides the ability to schedule specific Summary 
Reports for a selected store to be printed or saved to ExcelTM file format 
using the PC30A Scheduler. 
 
To open the Edit Reports Schedule for Stores dialog box shown 
below: 
 
! Select Edit Reports Schedule from the drop-down Scheduler 

menu, or… 
! Select Reports Schedule from the drop-down Edit menu, or… 

! Press the    button on the toolbar. 
 

The Edit Reports Schedule for Stores dialog box will appear. 
 

 
 
First select a store by clicking on its line in the Select a store list box.  
Use the scroll button to the right of the box if necessary. 
 
Next, choose the type of report (e.g.  DAYPART 1 or DAYPART 2, etc.) 
you would like from the Select a report list box.   Use the scroll button 
to the right of the box to view the list of report types available. 
 
NOTE:  The Print and Save columns in the Select a report list box 
indicate whether a report has been selected for printing or saving 
(exporting) to file. Saved reports are located in 
C:\ProgramFiles\Hme\PC30A\ActivePC30AdbStores. 
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The following table lists the types of reports that can be scheduled: 
  

Report 
Type 

Report 
Parameter(s) 

Report Frequency 
The following report rates are dependent on the 
rate at which the RCD (Raw Car Data) is 
collected.  If a report is scheduled, but the raw car 
data has not yet been collected to compute the 
report, the affected report will become delinquent.  
Once the RCD has been collected via the RCD 
Scheduler (to cover this Summary Report’s time 
period) the report and all other similarly delinquent 
reports will be printed and/or saved. 

DAY 0 (Not Applicable) Once a day at the end of the store hours. 
DAYPART 1-12 After the completion of the specific Daypart. 
HOUR 0-23 After the completion of the specific hour 
MONTH 0 (Not Applicable) After the completion of each month 
SHIFT 1-3 After the completion of the specific shift. 
WEEK 0 (Not Applicable) After the completion of each week. 
YEAR 0 (Not Applicable) After the completion of the fiscal year. 

 
Each report can be scheduled by enabling either the Print or Save flags, 
using Print Report and Save Report checkboxes.  When the report is 
scheduled for printing or saving, the Print or Save cells will change from 
No to Yes.  If the report interval is OFF (such as Shift or Daypart), the 
Last Report Date will indicate it by displaying OFF in the appropriate cell.   
 
The Scheduled Reports will be generated after a successful Raw Car 
Data acquisition session for the scheduled store, if the Date/Time of the 
RCD session exceeds the end of the report period.  In other words, the 
Scheduled Report will not be generated until the Raw Car Data has 
been collected for that report interval. 
 
NOTE:  By checking a box, the coinciding status field in the grid for print 
or save is updated. 
 
! To enable all reports use the Schedule All button.   

CAUTION:  This will cause a report to be generated for every type 
of Summary Report available after each Report’s time period has 
been completed. 

! To disable all reports use the Clear All Reports button.  This will 
disable all scheduled Summary Reports.   

 
You have the option to begin scheduling at a given day by entering the date in 
the Last Report Date column.  “Last Report Date” implies the scheduled 
report will be generated for the next report period.  (e.g.  If the “Last Report 
Date” for a Day report contains 05/14/2001 11:29:59 PM [U.S.A. date/time 
locale], the next Day report will be generated for 05/15/2001). 
 
NOTE: If the report is scheduled for the first time, the PC30A defaults the “Last 
Report Time” so only the most current report, which lies within the current 
report interval, is generated.  To start a report generation on a given day, use 
the Last Report Date column of the Select a report grid to enter the start 
date to begin scheduling report.  Remember to enter a date within the previous 
report period to generate a report for a given date. 
 
! Select the Close button to save the changes and exit the dialog box. 
! To verify the schedule of the reports, select From Database from 

the drop-down Reports menu, and select Report Schedule. 
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Viewing and Editing Store Settings 
 
View and Edit System 30 Timer Settings 
 
PC30A allows you to view and edit System 30 Timer Settings offline, as 
well as download and upload them from/to timers and files. This capability 
provides you with the power to remotely modify the settings of a given 
store’s timer, which affects the operation of the timer without having to be 
present at the store.  Once you are satisfied that the settings are valid, you 
can either save (upload) those settings groups to timer or to file.  The 
settings of the System 30 Timer that can be changed using PC30A are 
organized according to Settings Groups.  These Settings Groups include: 
! Installer Settings Group 
! System Settings Group 
! Report Setup Group 
! Remote Settings Group 
! Service Goals 
! Master Goals Settings Group 
! Daypart Goals Settings Group 

 

  
 

 
Installer Settings Group 
 
The Installer Settings for the System 30 include Lane Configurations, 
Queue and Service Times, Detector Settings and other configuration 
information.  Adjusting lanes, detectors or events will cause other 
Settings Groups to be initialized. 

 
Service Goals Group 
 
The Service Goals consist of Master Goals Group and Daypart Goals 
Group.  Use the Master Service Goals as a template for copying to 
Daypart Service Goals.  The Daypart Service Goals are used to control 
the application of the goals to the Summary Reports, Remote displays, 
and Alarms. 
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Remote Settings Group 
 
The Remote Settings are used to control the behavior of remote 
displays connected to a given System 30 Timer.  PC30A is able to 
configure either the R30 Remote Display Type or the later R31 
Multicolor Remote Display Type.  This group also has settings for the 
alarm feature of the System 30 Timer.  Refer to Installer Settings Group 
for settings such as Events, Lanes; and the Service Goals Settings for 
description of goals. 
 
System Settings Group 
 
The System Settings are used to control store hours, Accounting, 
Passcodes, Shifts and Dayparts hours. These settings are adjusted 
using the following methods.  Changes to these settings should not 
affect other settings groups. 
 
Report Setup Group 
 
The Report Setup group is used to control when scheduled reports are 
to be printed at the System 30 Timer. 
  
Settings Group Relationships: 
 
PC30A automatically adjusts individual settings that are affected by 
these settings groups in order to make sure that they remain valid for 
uploading to a given store timer, using the following rules:    
 
1. Defaulting the settings using the Default Groups method 

Default/Download/Upload Settings causes all Settings Groups to 
be defaulted to a known state (according to the selected lane 
configuration). 

2. Changing the Lane causes the Installer Settings Group, the  
Master Goals Group, the Remote Setup Group, and the Daypart 
Goals Group to be defaulted. 

3. Changing the Detection Type in the Installer Settings Group 
causes the Master Goals Group, the Remote Setup Group, and 
the Daypart Goals Group to be defaulted. 

4. Changing the Events in the Installer Settings Group causes 
change of the corresponding Events in the Master Goals Group, 
the Remote Setup Group, and the Daypart Goals Group. 

5. Changing the Goals in the Master Goals Group causes these 
goals to be copied to all Daypart Goals, replacing any previously 
set individual Daypart Goals. 

6. Any changes to other settings within the Settings Groups do not 
affect other settings. 
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Initial Edit Settings Screen: 
 
The following screen depicts the initial view that you get when you start 
to edit settings.  Any time you enter this screen from the 
Menu>Edit>Edit Settings menu selection, PC30A preloads the setting 
values with SINGLE-LANE Default settings.  The first step in editing 
settings is to press the Open button to choose the source to be edited.  
It can be one of the stores from the Store List, or Single/Dual Lane 
Default, or User-Defined Files (which have been saved during previous 
editing sessions). 
 
CAUTION:  While you are in the Edit Settings Screen, the RCD 
scheduler and report scheduler are disabled and will delay the 
gathering of data and reports.  Be sure to exit this dialog box once 
you are finished editing settings! 
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Open (Download) Settings for Viewing or Editing 
 
After pressing the Open button, the following dialog box appears 
prompting you to select the source of the settings to be edited. Select 
the source of the settings to be edited by clicking on a line of the Store 
List provided.  Note also the ability to edit a Timer’s time/date, which is 
covered on page 48. 
 

 
 
 
Opening Settings From a File 
 
! Default Settings 

You can open settings for defaults including Single and Dual Lane 
Configurations.  These settings are pre-configured and may not reflect 
the exact values you want to use for your store; however, they are a 
starting point for creating timer settings that are specific to your needs. 
 

! User Files 
You can open settings that you have previously saved on disk.  These 
files contain all of the setting changes you made prior to saving them.  
These are useful for archiving different configurations prior to their 
being saved (uploaded) to actual timers.  Note that these files must be 
created by PC30A.  By selecting an Installer Settings file (with the 
name:  *_INST.TXT), PC30A will open the rest of the settings files 
automatically.  
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Opening Settings Directly from the Timer 
 
PC30A allows you to directly connect to a store timer and acquire its 
settings for editing.  This approach would be used if you do not want to 
collect Raw Car Data for a store, but would rather change settings only. 
 
! Select the Store for which you want to open settings. 
! After you press the OK Button, the following dialog box appears to 

connect to the store you selected. 
! Once connected, PC30A gets the settings from the store timer, and 

then disconnects from the store.  You will then be able to edit those 
settings immediately. 

! Store Timer Files 
You can open settings for a specific store timer included in the list of 
timers.  These store timer entries were created in the Edit Stores 
dialog box (see Editing Stores).  Note that stores which are added to 
the store list, but do not have their settings retrieved yet, will not be in 
the list.  In order to edit settings for a given timer, the settings for the 
timer must be downloaded first.  Use the Edit Store Dialog Box (See 
Editing Stores) to ensure that the Get Scheduled Settings box is 
checked for stores whose settings you wish to change.  You should 
also make sure that the settings for a given store are current before 
you attempt to edit them.  This can be done by acquiring Raw Car 
Data for a given store either via a scheduled RCD collection or a 
manual RCD collection to the store prior to editing the settings files.  
(See Manually updating Car Data from a Store Timer). 
 

If the files associated with the store exist, then you will be able to edit 
those settings immediately.   
 
If the following warning appears, you need to follow the procedure 
above to make sure that the timer settings files exits. 
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Editing Individual Settings 
 
The individual settings that you can edit are numerous, but are 
organized in groups.  You start out by selecting the group you are 
interested in viewing/editing.   
 
Use the Group pull down menu to select which group of settings 
you want to view/change.  The figure below, shows an example for 
the Installer Settings Group. 
  

 
 
Select one of the tabs, which help organize a given group’s settings.  In 
this case you can choose from General Tab or Detector Points Tab for 
the Installer Settings Group. 
 
Now click on specific Value fields in the Settings Grid to enter edit 
specific values.   
 
There are two ways to edit a cell in the Value column. 
 
1. If you click in a cell and a small button appears at the right end of  the 

cell, you must click on the button to see what options are possible, 
such as selecting corresponding values or dates/times, etc. 

2. If you click in a cell and no button appears at the right end of the  
cell, you can edit the value directly. 

 
NOTE:  Below the settings grid is a text box that explains the meaning 
of a given setting.  Use this to guide your editing as well as consulting 
your System 30 Timer Operating Instructions Manual. 
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You can select other Settings Groups from the Group pull down menu.  
You then follow the above procedures until the settings for your Store 
Timer are exactly as you want them. 
 
You are now ready to save the settings back to a timer or user file. 
 
 
Saving (Upload) Settings 
 
After completely editing the timer settings, you can save them to one of 
three locations:  an actual Timer, a User File, or a Timer Settings File. 
 
NOTE:  By saving settings to a Timer, PC30A will synchronize the 
settings of the System 30 Timer and Timer files on the PC. 
 
 
Canceling an Edit Session 
 
CAUTION:  If you press the Cancel button, you will lose all settings 
changes you have made since the last time you saved the settings. 
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Edit Timer Time 
 
Edit Time of the Store Timer 
 
The PC30A can be used to set/adjust current System 30 Timer time.  To 
edit the time, select “Edit time/date of the Timer” option in the “Edit Store 
Settings Selection” dialog, highlight the Store you are going to edit and 
press the OK button. 
 

 
 
It will open the following “Edit System 30 Timer time” window. 
 
Using this dialog box, you can: 
 
! Adjust current Timer time by moving 

the time backward or forward using 
Relative Time Adjustment.  You 
can adjust the Timer time using this 
option up to a maximum of + or – 25 
hours.  Use this approach if you 
simply want to shift time from the 
current Timer baseline. 

NOTE:  Negative Time Offset indicates 
the Timer time is slower than the time 
on the PC. 
 
! Set Date and Time using Absolute 

Time Adjustment.  This option 
allows you to set the time regardless 
of the current Timer time. 

! Set Automatic Daylight Savings flag 
using Edit Daylight Savings to 
allow Timer to automatically adjust 
time when daylight savings 
adjustment occurs in fall and spring time periods. (For all version 
timers other than A.2.3* and K.2.3*) 

NOTE: The daylight savings will always be disabled in A.2.3* and K.2.3*. 
CAUTION: When editing time backward, the Timer time should not 
be moved before the System 30 Last Raw Car Data Record time, or 
the Timer database may become corrupt.
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3.6.3 View Menu 
PC30A provides a View screen in order to preview reports prior to exporting or 
printing them.  This screen continues to display the last requested report until a 
new report is generated or the screen is cleared. 
PC30A displays the latest operational error on the Main Screen to show the cause 
of a failed operation.  In order to avoid confusion, before starting another operation, 
the previous error can be cleared using the View Menu.  
 

 
 
! Select Clear Screen on the View menu to clear the Report View. 
! Select Clear Previous Error on the View menu to clear the Error Status Line. 
 
Clearing the Screen 
 
PC30A provides you a View screen for previewing reports prior to exporting or 
printing them.  This screen continues to display the last requested report until a 
new report is generated or the screen is cleared. 
Select View on the Menu Bar for the drop-down View menu. 
 

 
 
Select Clear Screen on the View menu to clear the Report View. 
 
Clearing Previous Error 
 
PC30A displays the latest error on the Main Screen to show the cause of a failed 
operation.  In order to avoid confusion, before starting another operation, the 
previous error can be cleared. 
Select View on the Menu Bar for the drop-down View menu. 
 

 
 
Select Clear Previous Error on the View menu to clear the Error Status Line. 
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3.6.4 Store Menu 
The Store menu enables you to make network, direct serial or modem connections 
to timers.  You can also disconnect from a currently connected store timer using 
this menu.  The Store menu also allows you to open a dialog box for editing 
stores.  Finally, you can refresh (update) the Raw Car Data from the currently 
connected store.  
Select Store on the Menu Bar to view the drop-down Store menu. 
 

 
 
! Select Connect on the Store menu to view the Manually Connect to Store 

dialog box, to connect to any of the stores listed in the Store List, or to edit 
the list. 

! Select Direct Serial Connect on the Store menu to connect PC30A to a local 
store timer connected to your PC via serial Com port. 

 

 
 
! Select Disconnect on the Store menu to disconnect from the connected store 

timer.  
! Select Edit Stores on the Store menu to open a dialog box for editing stores 

options.  
! Select Monitor On on the Store menu to start monitoring a store timer that has 

been connected.  Note that you can continue to monitor a store after you 
disconnect from that store. 

! Select Monitor Off on the Store menu to stop monitoring a store timer.  
! Select Refresh RCD for connected store on the Store menu to refresh RCD 

from the connected store timer. 
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Manually Connecting to a Store timer 
 
! Select Store from the Menu Bar and select Connect from the drop-

down menu,  or…  
! Select Store from the Menu Bar and select Direct Serial Connect 

from the drop-down menu,  or… 
 

! Select the               button. 
 

The Connect to Store dialog box will appear.   Select a store from the 
Store List as follows.     
 

 
 
Store Selection 
 
To select a store timer, use the Store List grid and highlight the row 
containing the desired store.  Stores are identified by StoreID, Store Name, 
and Connection type.  Use a mouse or up/down arrows of the keyboard to 
scroll from store to store.  Note the connection type for each store, which 
indicates how the store timer is connected (NETWORK, MODEM or DIRECT). 
 
Activity Log 
 
The Activity Log monitors the progress of the connection already in 
progress and displays any visible feedback about the connection.  It 
also shows any communication or settings errors that may occur while 
trying to connect to a store.  For troubleshooting communications, 
checking the View Debug Commands checkbox allows the Activity Log 
to display the communication data sent between PC30A and the 
Modem/Timer. 
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Connect 
 
To start a connection, after the store has been selected, click on the 
Connect button (or use Alt + ‘n’ shortcut).   
 
Disconnect 
 
To cancel the connection attempt, while it is in progress, use the 
Disconnect button (or use Alt + ‘d’ shortcut).   
This command will close the dialog box. 
 
Abort 
 
To abort the current connection attempt without closing the dialog box, 
use the Abort button (or use Alt + ‘a’ shortcut).  This command leaves 
the dialog box open for another connection. 
 
Edit 
 
To edit the currently selected store, use the Edit button (or use Alt + ‘e’ 
shortcut), which will open the Edit Stores dialog box so the selected store 
can be edited. After making the desired changes, select Save Store or 
Cancel, then select Close to close the Edit Stores dialog box and to 
return to the Manually connecting to a store dialog box. 
 
Close 
 
To cancel the connection attempt, while it is in progress, select Close 
(or use Alt + ‘c’ shortcut), to close the dialog box and abort any 
connection attempt in progress. 
 
Note:  The View Debug Commands checkbox can be selected to 
display the connect commands for debugging purposes. 
 
Manually Disconnecting from a Store Timer 
 
After you have connected to a System 30 Timer and collected its raw 
car data, you must disconnect from the timer before connecting another 
store’s timer or exiting the program.   
 
CAUTION:  Do not disconnect PC30A from a Timer while it is collecting 
data, or the file associated with the data may lose some records. 
 
To manually disconnect PC30A from a System 30 Timer, select Store 
from the PC30A Menu Bar, and select Disconnect from the drop-down 

menu, or select the    icon from the button bar to disconnect.  
 

NOTE:  After 5 minutes of 
inactivity (i.e. no new functions 
involving the connected store 
timer), if you have not 
disconnected from the timer, 
the PC30A will automatically 
be disconnected. 
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Manually Updating Car Data from a Store Timer 
 
If you are connected to a Timer, you can update the Raw Car Data from an 
the store by selecting Store -> Refresh RCD for connected store from the 
drop-down menu.  The Getting RCD for the Connected Store dialog box 
will appear and remain open while the Raw Car Data and Timer settings 
are being imported into the Active PC30A Database.  This function collects 
Raw Car Data from the store Timer into the active database and into an 
export file (for further distribution of RCD to other computers running 
PC30A, for example).  Once completed, the Getting RCD for the 
Connected Store dialog box will close. 
 

 
 
The dialog box consists of the Activity Log, Acquisition Progress bar 
and Abort button. 
 
Activity Log 
 
The Activity Log monitors the progress of the Raw Car Data and settings 
acquisition and displays feedback about the connection.  The Activity Log 
shows step-by-step status while data is being transferred from the timer 
into a text file, or while the text file is being imported into the database. 
 
Acquisition Progress Bar 
 
The Acquisition Progress bar shows the activity of the Raw Car Data 
transfer from the Timer to the text file, and of the text file into the Active 
Database.  The progress bar does not indicate the completed percentage  
of data acquisition, but simply indicates that PC30A is busy acquiring data. 
 
Abort Button 
 
To cancel the acquisition of the RCD and close the dialog box, select 
the Abort button.   
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Monitoring Car Activity at a Store Timer 
 

Store Monitor 
 
PC30A gives you the ability to monitor the activity of a given Store Timer 
by displaying Car Records for all vehicles as they pass through the Drive-
Thru Lane of a store.  The benefits of this feature allow you to see what 
times cars are experiencing for critical times of the day.  A store manager, 
running PC30A can use this active information to determine which areas 
of the Drive-Thru Lane need improvement in terms of speed of service.   
 
Starting Store Monitor while connected to a Store Timer 
 
You can initiate the Monitor only if you are already manually connected to a 
store (See Manually Connecting to a Store Timer for instructions on how to 
connect to a store).  Once connected to a store timer, you will notice that the 
Disconnect and the Monitor toolbar buttons on the main frame become active. 
 
In order to start the Monitor on a connected  
store timer, select the Monitor toolbar button:   
 
PC30A reacts by reducing the size of the report display and creating a 
monitor grid.  This monitor grid is not initialized until the first monitor 
event from the Timer is received as shown below. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As PC30A receives new car records from the Store Timer, it displays 
them from top-to-bottom order on the monitor grid as shown below.   
The information included in the monitor includes: 
! Departure Date 
! Departure Time 
! Event Times at particular detectors 
! Queue Times that follow the previous detectors 
! Lane Number that car passed through 
 
The monitor is self-limiting in terms of the number of Monitor records 
that are displayed.  Only the newest 50 cars are displayed on the 
scrolling monitor grid. 

  

  

Monitor 
grid 
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Continuing to Monitor a Store without a Command Connection to a 
Store Timer 
 
It is possible to disconnect from the timer in the sense that no more 
commands are sent to the timer and still display monitor events as they 
occur.  If you plan to monitor cars at a store for extended periods of time 
that exceed 5 minutes, it is recommended that you disconnect from the 
store timer, leaving the monitor enabled and the physical connection 
(modem and port) intact. 
 
In order to disconnect from the store timer (in terms of commands) while 
still monitoring the store, select the Disconnect from Store toolbar button:  
 
PC30A reacts by maintaining a physical connection to the store timer 
(Network, Modem or Direct serial connection), but stops sending 
commands to that timer.   At this point the store timer continues to send 
monitor events to the PC30A’s monitor grid for your review. 
 
Stopping Store Monitor  
 
Whenever you enter monitor mode, PC30A  
provides a toolbar button to turn off the Monitor.   
 
Use this button to kill monitor mode in which case the monitor grid 
disappears and PC30A is physically disconnected from the Store Timer. 
 
NOTE:  While in the Monitor mode, PC30A disables the input of reports 
to the PC from the Store Timer.   
 
While in the Monitor mode, running the Raw Car Data scheduler will 
terminate the Monitor mode. 



 56 

3.6.5 Reports Menu 
The Reports menu enables you to obtain reports manually (on demand) in 
addition to the automatically generated, scheduled reports, based on either the 
active or archived database, or from the currently connected store timer. 
Select Reports on the Menu Bar to view the drop-down Reports menu. 
 

 
 
! Select From Timer on the Reports menu to generate summary reports from the 

connected timer. 
! Select From Database on the Reports menu to select reports to be generated 

from the database. 
 
Generating Reports 
 
The PC30A provides you with powerful reporting capabilities.  It is possible for you 
to generate On-Demand Reports that can be viewed in the Report Viewer from two 
data sources: 
! The Active / Archive Database. 
! The System 30 Timer, to which you are currently connected. 



 57 

The PC30A allows you to create the following types of Reports and Settings: 
 

REPORT 
TYPE 

FROM 
TIMER 

FROM 
DATABASE DESCRIPTION 

Hour 
From 
connected 
Timer 

From specified 
store ID in 
database 

Summarized Drive-Thru Activity Report(s) 
for specified hour / multiple days. 

Day-part 
Summarized 

From 
connected 
Timer 

From specified 
store ID in 
database 

Summarized Drive-Thru Activity Report for 
specified daypart averaged over multiple 
days. 

Day-part 
Itemized 

From 
connected 
Timer 

From specified 
store ID in 
database 

Summarized Drive-Thru Activity Report(s) 
for specified daypart / multiple days. 

Shift 
From 
connected 
Timer 

From specified 
store ID in 
database 

Summarized Drive-Thru Activity Report(s) 
for specified shift / multiple days. 

Day 
From 
connected 
Timer 

From specified 
store ID in 
database 

Summarized Drive-Thru Activity Report(s) 
for multiple days. 

Week 
From 
connected 
Timer 

From specified 
store ID in 
database 

Summarized Drive-Thru Activity Report for 
specified week. 

Month 
From 
connected 
Timer 

From specified 
store ID in 
database 

Summarized Drive-Thru Activity Report for 
specified month. 

Year to Date 
From 
connected 
Timer 

From specified 
store ID in 
database 

Summarized Drive-Thru Activity Report for 
current year 

RCD 
From 
connected 
Timer 

From specified 
store ID in 
database 

Raw Car Data Records for every car 
passing through Drive Thru.  * 

Every-Car 
Report 

From 
connected 
Timer 

Use RCD Report 
instead 

Real-time Drive-Thru Activity Report for 
individual cars 

All Settings 
From 
connected 
Timer 

From specified 
store ID in 
database 

List of all settings for the store Timer. 

Installer 
Setup 

From 
connected 
Timer 

From specified 
store ID in 
database 

Installer settings (Lane Configuration 
Queue, and Service Timer, Detector 
Settings) Report 

Service 
Global Setup 

From 
connected 
Timer 

From specified 
store ID in 
database 

Service goals report consists of goals used 
to report Drive-Thru Efficiencies in 
Summary Reports. 

Day-part / 
Shift Setup 

From 
connected 
Timer 

From specified 
store ID in 
database 

List of dayparts and shifts used to divide the 
store day for reporting 

Report Setup 
From 
connected 
Timer 

From specified 
store ID in 
database 

List of reports that are scheduled to be 
printed at the store Timer 

System Setup 
From 
connected 
Timer 

From specified 
store ID in 
database 

Store Id, pass codes, firmware version, 
store hours 

Excess Time 
From 
connected 
Timer 

From specified 
store ID in 
database 

Summary of event times exceeding a 
specified Timer 

Inactivity 
From 
connected 
Timer 

From specified 
store ID in 
database 

Summary of inactivity time in the drive-thru 
lane 

Comparison 
Summary 

From 
connected 
Timer 

From multiple 
stores 

Multiple summarized drive-thru activity 
reports for comparison of stores 

* NOTE: This report displayed in the Report Viewer is only a representation of the data, since 
this report is intended to be saved to file, rather than completely viewed for printing, etc. 
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Report Formats 
 
The following reports listings are examples of the types of reports that are available 
from the PC30A Application: 
 
Summary Report from Connected Timer 
 
These Timer Summary and Settings Reports are acquired from the Connected 
Store Timer and are formatted exactly as they would be printed at the timer’s 
printer.   
 
NOTE:  Multiple reports can be obtained and appended to additional blank 
columns in order to do comparative analysis if desired.  If more than 4 reports are 
requested, they will be added to the next available blank page, starting in the first 
column. 
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Raw Car Data Report from Connected Timer 
 
Note that if you acquire an RCD report, this Report is saved to file and a 
representation of the report is placed on the Report Viewer (the entire report is not 
shown since this is exclusively a filed report).   
This Timer-derived RCD Report provides a column for all events that are possible.  
In addition, record times, record event titles, record types (pull outs, departures, 
resets, etc.), number of cars in lane at the time of the record, and lane are added 
to this record. 
 

 
 
The following is an excerpt from the file that is saved for this report: 
 
 
 
 
 
 
 
NOTE:  This file can be imported into a database or spreadsheet.  The data will not 
appear wrapped as it does in this example, but will be extended to its horizontal 
limits. 
 

 
Date,Time,Arrival,Alert  ,Booth  ,Cashier,Delivry,Greet  ,Greet 1,Greet 2,Menu   ,Menu  1,Menu  2,OrderPt,Order1 ,Order2 ,Pickup ,Pre-Alt,Pre-Lp ,Presntr,PWarn  
,Service,WaitAr ,Window1,Window2,QArrival,QAlert  ,QBooth   
,QCashier,QDelivry,QGreet  ,QGreet 1,QGreet 2,QMenu   ,QMenu  1,QMenu  2,QOrderPt,QOrder1 ,QOrder2 ,QPickup ,QPre-Alt,QPre-Lp ,QPresntr,QPWarn  
,QService,QWaitAr  
,QWindow1,QWindow2,Lane,CarsInQ,Event,StoreID 
9/14/2005,3:19:57 PM,0,0,0,0,0,9,0,0,9,0,0,0,0,0,7,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,11,0,0,0,0,0,0,0,0,0,0,0,0,0,0,1,2,Car_Departure,0 
9/14/2005,3:20:10 PM,0,0,0,0,0,11,0,0,11,0,0,0,0,0,4,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,12,0,0,0,0,0,0,0,0,0,0,0,0,0,0,1,2,Car_Departure,0 
9/14/2005,3:20:25 PM,0,0,0,0,0,7,0,0,7,0,0,0,0,0,11,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,4,0,0,0,0,0,0,0,0,0,0,0,0,0,0,1,2,Car_Departure,0 
9/14/2005,3:20:40 PM,0,0,0,0,0,12,0,0,12,0,0,0,0,0,4,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,6,0,0,0,0,0,0,0,0,0,0,0,0,0,0,1,2,Car_Departure,0 
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Raw Car Data Report from Database 
 
This report is generated from the Active or Archived Database rather than from a 
Connected Timer.  The format of this report limits the columns to the detection 
points and the events that make up the Timer configuration.  This is different from 
the Timer-derived RCD Report, which provides a column for all events that are 
possible.   
In addition, record times, record event titles, record types (pullouts, departures, 
resets, etc.), number of cars in lane at the time of the record, and lane are added 
to this record. 
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Summary Report from Database (Hour Report Example)  
 
This report contains totals for each Timer event, percent of cars under particular 
goals and other statistics. 
 
NOTE:  This example is for an Hour Report.  Summary Reports for other time 
periods (such as Daypart, Shift, etc.) follow the same format, with different time 
ranges.   
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Settings Report from Database (Installer Settings Report Example)  
 
PC30A maintains a local copy of a Store Timer’s settings that are transferred from 
the Timer.  These settings are used to calculate Summary Reports from the 
database.  These reports are similar to the Settings Reports that can be printed 
from a store timer; however, the Timer Reports are formatted in a more user 
friendly format (see Getting Summary Reports from a Store Timer). 
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Getting Summary Reports from a Store Timer 
 
To generate a Summary Report from the Store Timer, select Reports from the 
Menu Bar followed by a selection of From Timer and Summary Reports…   The 
following dialog box appears: 
 

 
 
NOTE:  The Database Range field in the Dialog Box ranges from the Departure 
Time of the first record in the System 30 Timer Raw Car Data Database to the 
current time of the System 30 Timer, for the currently connected store.  The 
System 30 Timer Raw Car Data Database range applies to the following reports: 
 
! Every Car Report 
! Hour Report 
! Shift Report 
! Daypart Report 
! RCD Report 
 
The Database Range field in the Dialog Box ranges from the Departure Time of 
the first record of the System 30 Timer Summary Database to the current time of 
the System 30 Timer, for the currently connected store. The System 30 Timer 
Summary Database range applies to the following reports: 

 
! Day Report 
! Week Report 
! Month Report 
! Year To Date Report 
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Click on the down arrow to the right of the Choose a Report box to view the drop-
down menu, and choose a report.  Based on the type of report chosen, other edit 
controls in the dialog box will be enabled to allow you to select report parameters 
for the report type.  The table below lists the edit controls that need to be set in 
order to acquire the report. 
 
REPORT TYPE OTHER EDIT CONTROLS 
All Settings Reports Get Report 
Every Car Report Report Range Dates and Times and Get Report 
Hour Report Report Range Dates and Start Time and Get Report 
Daypart Report Options (Summary or Individual) and Daypart and Report Range Dates 

and Get Report 
Shift Report Shift and Report Range Dates and Get Report 
Day Report Report Range Dates and Get Report 
Week Report Report Range Start Dates and Get Report 
Month Report Report Range Start Dates and Get Report 
Year to Date Report Range Start Dates and Get Report 
RCD (Raw Car Data) Report Range Dates and Times, Options (comma or tab) and Get Report 
Blank Get Report (Generates a blank report) 

 
NOTE:  The PC30A must be connected to a System 30 Timer to access these 
reports. 
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Getting Summary Reports from the Database 
 
To generate a Summary Report from the Active Database, select Reports from 
the Menu Bar followed by a selection of From Database and Summary 
Reports…  The following dialog box appears: 
 

 
 
NOTE:  The Database Range filed in the Dialog Box reflect the Departure Times of 
the first and the last records in the PC30A Active Database for the currently selected 
store.  The Database Range applies for all reports from the PC30A Active Database. 
 
Click on the down arrow to the right of the Choose a Report box to view the drop-
down menu, and choose a report.  Select which store Timer’s data is to be used to 
generate the report by selecting the store in the Select Store list box. 
 
Based on the type of report, other edit controls in the dialog box will be enabled to 
allow you to select report parameters specific to the report type.  The table below 
lists the edit controls that need to be set in order to acquire the report. 
 
REPORT TYPE OTHER EDIT CONTROLS 
Settings Reports Get Report 
Every Car Report Not Supported, use RCD Report 
Hour Report Report Range Dates / Start Time and Get Report 
Daypart Report Daypart and Report Range Dates and Get Report 
Shift Report Shift and Report Range Dates and Get Report 
Day Report Report Range Dates and Get Report 
Week Report Report Range Dates and Get Report 
Month Report Report Range Dates and Get Report 
Year to Date Report Range Dates and Get Report 
RCD (Raw Car Data) Report Range Dates  / Times, Options (comma or tab) and Get Report 
Blank Not Supported 

 
NOTE:  You can use an alternate database for your source by selecting the Open 
Archive button.  This archive database is not used to collect new RCD, but rather 
for reporting archived data collected in previously active databases that have been 
archived.  It is closed when summary Report Dialog is closed. 
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Getting Other Miscellaneous Reports 
 
In addition to Summary Reports, you can also generate three reports that reflect 
active database settings for controlling how PC30A operates. 
! Report Schedule:  controls when selected summary reports from the Active 

Database are to be printed or saved to Excel files. 
! Comparison Report Schedule:  controls when selected summary reports from 

the Active Database are to be printed or saved to Comparison Reports. 
! Stores:  list of stores that are part of the database for connecting and collecting 

Raw Car Data. 
! Scheduled RCD History:  summary of Raw Car Data collection for all stores 

for a given time interval. 
! Options:  list of global settings that control Raw Car Data collection rates, RCD 

retries due to failures, Com Ports report time format (min:sec or seconds only). 
 
In order to start these reports, select Reports from the Menu Bar, and then select 
From Database and Report Schedule, Stores or Options from the drop-down 
menus.  The selected report will be generated immediately.  Select Scheduled 
RCD History to activate a dialog box for Start and Stop times for this report. 
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Getting Customized Reports 
 
Customized report form contains 3 kinds of reports: 
! Excess Time report  –  provides a summary of cars that exceed a given 

time interval for a given event (detection point or total). 
! Inactivity Time report  –  provides reporting of event (detection point or 

total) inactivity time within set parameters (detailed report). 
! Comparison Summary report  –  multiple reports in a compact form to allow 

comparison of different Stores, different time intervals, different report types. 
 
NOTE:  All these reports require setting parameters before obtaining the report 
(setting filters). 
 

 
 
Step 1: Select which report you want to receive in “Choose a Report”  
   combo box. 
 
To receive an Excess Time report: 
 
Step 2: Select a particular Store from “Select Store” grid for which you want to  
   receive the report. 
   NOTE:  This report is designed for one Store at a time, but it can be  
   used for multiple detector events (up to 8 filters). 
Step 3: Set Start and Stop time of the report using “Report Range” controls for 

dates and times.  
Note: Database Range window under these controls shows you a valid 
Start/Stop Times for this Store from the database. 

Step 4: Choose a detector event from a pull down list “Detector Event”. 
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Step 5: Set the desired Time interval you want to be reported for selected  
detector. 

Step 6: Press “Add New Filter” button. This will populate Filter grid with  
selected parameters. 

 

 
 
Repeat Steps 4-5 for additional detectors (Max 8 events) if necessary. 
 
! If you decided to change detector event or time interval after setting a filter, you 

can do it by editing the Filter Grid itself.  Press the corresponding “down arrow” 
button at the right corner of the grid column.  It will open a corresponding pull 
down list for detector events or time picker control for time intervals. 

! If you want to delete a filter from a Filter grid, highlight corresponding row 
and press the “Delete Selected Filter” button. Thus you can delete all you 
selected filters one at a time and start from the beginning. 

! To get a report after you are completely satisfied with the Filter selection, 
press Get Report button.  
You can restore the filter you used to receive a report, if right after getting 
the report you press the Restore previous report filter button (which any 
other time serves as Delete selected filter button). 

 
NOTE: Selecting a new Store in the Select Store grid will default all selected 
detectors in a filter to the first activated detector from the new detector event list 
for this Store.  
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To receive Inactivity Time report: 
 
STEPS:  Follow the same steps as for Excess time report. 
 
CAUTION:  This report shows each encountered inactive time interval within given 
Start/Stop dates. This can cause a multiple pages report. For example: Start/Stop 
chosen for one year and Time interval = 1 sec, will generate report for each 
second of this year  possible 86400 * 365 events. 
 

 
 
 
 
 



 70 

To generate a Comparison Summary report : 
 
Step 1: Choose the Comparison Summary Report pull down entry. 
Step 2: Select Store from “Select Store” grid. 
Step 3: Select Report from “Include Report” pull down list. 
Step 4: Set Start/Stop dates/times in “Report Range”(if applicable for  
   selected report) 
Step 5: Choose what kind of report you want to receive. Select Summarized  

or Individual in Report Options pull down list. 
Step 6: If in Step 2, Shift/Daypart report has been chosen, set the desired  

Shift/Daypart number under Report Options. 
Step 7: Press Add New Filter button to send the data from controls into  
   Filter Grid. 
 
If you want to edit individual filters in the Filter grid, press the right corner button in 
a given Filter column. 
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Selecting a new Store in a first column of the grid will reset all controls for this row 
in a Filter grid. Selecting new Report type in a second column of the Filter grid will 
reset Start/Stop date/times columns and DP/Shift column if applicable. 
 
Maximum number of filter you can set for the Comparison report = 15.  
 
CAUTION:  This report can cause multiple pages report even with only one filter. 
For example:   
Day report for any Store from 1/1/2000 till 1/1/2001 with Individual flag set in a 
report Options will generate a Day Comparison report for 365 days = almost 60 
pages report.   
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3.6.6 Scheduler Menu 
The Scheduler menu enables you to control the scheduler, forcing it to pause and 
resume acquisition of data from connected store timers.  It allows you to edit which 
reports are to be scheduled for printing or to be saved to file from data stored in the 
database.  You can use it to force the scheduler to run in order to get the latest 
Raw Car Data (RCD) from store timers, or to print any reports that have not yet 
been run. 
 
Note:  If your PC enters into Standby mode the Scheduler will be disabled.  
System Standby should be disabled for optimal Scheduler operation. 
 
Select Scheduler on the Menu Bar to view the drop-down Scheduler menu. 

 
! Select Pause from the Scheduler menu to pause the scheduled acquisition 

of RCD or a scheduled report from being generated. 
! Select Resume from the Scheduler menu to resume scheduling of RCD 

acquisition and generation of scheduled reports. 
! Select Edit Reports Schedule from the Scheduler menu to view the Edit 

Reports Schedule for Stores dialog box. 
! Select Edit Comparison Schedule from the Scheduler menu to view/change 

when Comparison Summary Reports are scheduled. 
! Select Update RCD for All Stores from the Scheduler menu to obtain Raw 

Car Data for all stores in the Stores list. 
! Select Force Reports Scheduler from the Scheduler menu to cause the 

report scheduler to run and generate all reports, both summary and 
comparison summary that have become due. 
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Pausing / Resuming the Schedule 
 
You can control the scheduler for RCD collection and Report generation using the 
Pause and Resume menus.  
 
Note:  If your PC enters into Standby mode the Scheduler will be disabled.  
System Standby should be disabled for optimal Scheduler operation. 
 

 
 
Selecting Scheduler from the Menu Bar, then  Pause from the drop-down menu 
will interrupt the scheduler connection to the scheduled stores and stop it from 
acquiring the Raw Car Data.  Pausing the scheduler will also prevent scheduled 
summary reports from being generated.  A paused scheduler will alter the PC30A 
icon on the PC30A main screen and the icon on the Windows taskbar to       . 
 
NOTE:  PC30A does not resume automatically!  Do not leave PC30A with Paused 
scheduler for long periods of time to avoid delaying scheduled reports. 
 
Selecting Resume will restart the scheduler connection to the scheduled stores 
and resume acquiring the Raw Car Data at the next scheduled time.  Resuming 
the scheduler will change the PC30A icon back to        . 
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Editing the Reports Schedule 
 
This dialog box provides the ability to schedule specific Summary Reports for a 
selected store to be printed or saved to ExcelTM file format using the PC30A 
Scheduler. 
 
To open the Edit Reports Schedule for Stores dialog box shown below: 
 
! Select Edit Reports Schedule from the drop-down Scheduler menu, or… 
! Select Reports Schedule from the drop-down Edit menu, or… 

! Press the    button on the toolbar. 
 

The Edit Reports Schedule for Stores dialog box will appear.   
 

 
 
First select a store by clicking on its line in the Select a store list box.  Use the 
scroll button to the right of the box if necessary. 
Next, choose the type of report (e.g.  DAYPART 1 or DAYPART 2, etc.) you would 
like from the Select a report list box.   Use the scroll button to the right of the box 
to view the list of report types available. 
 
NOTE:  The Print and Save columns in the Select a report list box indicate 
whether a report has been selected for printing or saving (exporting) to file. Saved 
reports are located in C:\ProgramFiles\Hme\PC30A\ ActivePC30AdbStores. 
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The following table lists the types of reports that can be scheduled: 
 
Report 
Type 

Report 
Parameter(s) 

Report Frequency 
The following report rates are dependent on the rate at 
which the RCD (Raw Car Data) is collected.  If a report 
is scheduled, but the raw car data has not yet been 
collected to compute the report, the affected report will 
become delinquent.  Once the RCD has been collected 
via the RCD Scheduler (to cover this Summary Report’s 
time period) the report and all other similarly delinquent 
reports will be printed and/or saved. 

DAY 0 (Not 
Applicable) 

Once a day at the end of the store hours. 

DAYPART 1-12 After the completion of the specific Daypart. 
HOUR 0-23 After the completion of the specific hour 
MONTH 0 (Not 

Applicable) 
After the completion of each month 

SHIFT 1-3 After the completion of the specific shift. 
WEEK 0 (Not 

Applicable) 
After the completion of each week. 

YEAR 0 (Not 
Applicable) 

After the completion of the fiscal year. 

 
Each report can be scheduled by enabling either the Print or Save flags, using 
Print Report and Save Report checkboxes.  When the report is scheduled for 
printing or saving, the Print or Save cells will change from No to Yes.  If the 
report interval is OFF (such as Shift or Daypart), the Last Report Date will 
indicate it by displaying OFF in the appropriate cell.   
The Scheduled Reports will be generated after a successful Raw Car Data 
acquisition session for the scheduled store, if the Date/Time of the RCD session 
exceeds the end of the report period.  This implies that the Scheduled Report will 
not be generated until the Raw Car Data has been collected for that report interval. 
NOTE:  By checking a box, the coinciding status field in the grid for print or save 
is updated. 
! To enable all reports use the Schedule All button.   

CAUTION:  This will cause a report to be generated for every type of Summary 
Report available after each Report’s time period has been completed. 

! To disable all reports use the Clear All Reports button.  This will disable all 
scheduled Summary Reports.   

 
Scheduled reports have option to begin scheduling at a given day by entering date 
in the Last Report Date column.  “Last Report Date” implies the scheduled report 
will be generated for the next report period.  (e.g.  If the “Last Report Date” for a 
Day report contains 05/14/2001 11:29:59 PM [U.S.A. date/time locale], the next 
Day report will be generated for 05/15/2001). 
NOTE: If the report is scheduled for the first time, the PC30A defaults the “Last 
Report Time” so only the most current report, which lies within the current report 
interval, is generated.  To start a report generation on a given day, use the Last 
Report Date column of the Select a report grid to enter the start date to begin 
scheduling report.  Remember to enter a date within the previous report period to 
generate a report for a given date.   
! Select the Close button to save the changes and exit the dialog box.   
! To verify the schedule of the reports, select From Database from the drop-

down Reports menu, and select Report Schedule. 
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Updating Raw Car Data for All Stores 
 
Select the Update RCD for all stores… option from the drop-down Scheduler 
menu to view the Getting RCD for All Stores dialog box,  
The Getting RCD for All Stores dialog box is used to get the Raw Car Data and 
store settings (See Store Edit) from all scheduled stores.  It is used to force the 
Scheduler to run whether or not any of the stores have outstanding RCD 
Acquisition retries or are late.   
NOTE:  If no stores exist in the database or no stores are scheduled, the Getting 
RCD for All Stores dialog box will not open.  
Running RCD scheduler successfully will “catch-up” the raw car data to the last 
scheduled session and void the retry session if it exits.   
 

 
  
The Getting RCD for All Stores dialog box is composed of the Activity Log box, 
Acquisition Progress bar, and the Abort button. 
The Activity Log monitors the progress of the Raw Car Data and settings 
acquisition, and displays any visible feedback about the connection.  It also shows 
any communication or acquisition errors that occur while data from a timer is being 
converted to a text file, or while the text file is being imported into the database.   
The Acquisition Progress bar shows the activity of the PC - Sys30Timer 
communication while receiving the Raw Car Data from a timer, and the import 
process while importing the RCD from the text file into the Active Database.  It 
does not indicate the completed percentage of the data acquisition, but simply 
indicates that PC30A is in a process of acquiring the data.   
To abort the current RCD acquisition and close the dialog box, click on the Abort 
button. 
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Forcing the Reports Scheduler to Run 
 
Select Force Reports Scheduler… from the drop-down Scheduler menu to view 
the Getting Reports for Scheduled Store dialog box. 
 
The Getting Reports for Scheduled Store dialog box is used to show the 
progress of the Reports Scheduler.  
This feature is used to restart the Reports Scheduler if the scheduled generation of 
reports was aborted by the user.   
The Reports Scheduler evaluates each scheduled report for each store to 
determine if there is enough Raw Car Data to generate scheduled reports.  The 
Reports Scheduler does not generate fractional reports (e.g. a half shift).  The 
Reports Scheduler will “catch-up” to the most recent scheduled reports session if 
one or more reports sessions were missed due to the Reports Scheduler being 
busy or paused, or to the PC30A not running. 
 

 
 
The Getting Reports for Scheduled Store dialog box is composed of the 
Activity Log box, Acquisition Progress bar and Abort button. 
The Activity Log monitors the progress of the Raw Car Data and settings 
acquisition and displays any visible feedback about the connection.  The Activity 
Log also shows any communication or acquisition errors that may occur while 
receiving the data from timer into a text file, or while importing the text file into the 
database. 
The Acquisition Progress bar is not used by the Reports Scheduler and is 
disabled the entire time the dialog box is displayed. 
Selecting the Abort button will complete the report currently being generated and 
close the dialog box. 
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Editing Comparison Summary Reports Schedule 
 
Scheduled Comparison Summary Report allows you to schedule multiple reports 
based on report type, each for multiple stores.  
 

 
 
Use the following steps to schedule the report. 
! Select a report you want to be scheduled using the “Select a Report” grid, which 

shows a list of all reports possible. 
! Check one (or both) of the “Print report” or/and “Save Report” check boxes. 

“Print Report” will cause report to be printed, “Save report” will cause the report 
to be saved at “ WorkingPC30A directory + 
\Database\ActivePC30AdbStores\ComparisonReports\” folder with the name 
corresponding PC30A file name convention. 

! If you want this report to include all Stores that you have in a database, press 
“Select All Stores” button. You will see that “List of Stores for selected Report” 
grid will be populated with the list of all Stores. 

! If you want the report not to include all Stores, but only some of them, press 
“Add New Store” button.  
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You will see a list of all Stores in a “List of all Stores” frame. Chose one by clicking 
(or double clicking) on the one of them. This action will cause “List of Stores for 
selected Report” grid to be updated by this new Store. Repeat these actions for 
each new Store you want to be included in a report. 
If you forgot to check one of the “Print/Save” check boxes while adding the new 
store, the report will be marked as needed to be Saved. 
! To remove a Store from a list of Stores to be included in a report, highlight a 

Store in “List of Stores for selected Report” grid and press “Delete Store” button. 
Repeat it for an each Store you want to remove. 

! To remove all Stores from the currently selected report, press the  “Clear All 
Stores” button.  The report will be unscheduled. 

 
“List of Stores for selected Report” grid will be empty for non-scheduled reports. 
“Last Report Date” column of the  “Select a Report” grid shows a date when this 
report has been obtained the last time. For newly scheduled Stores it will contain 
the yesterday report period. You can edit this field if you want to receive reports for 
the previous day intervals starting from this date by shifting the date back. If you 
will shift the date forward, the report won’t be generated till the “Last Report Date” 
become less than the PC Current Date. 
If in the past, the report has been scheduled for some time, and now you decide to 
schedule it again, be sure to put a correct date you want the report to be started. 
Otherwise you will receive reports for the whole period from the last time you 
stopped the scheduler for this report till the current time. 

 
Example of the Scheduled Comparison report for the Day report from the 
above screen: 
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3.6.7 Help Menu 
The Help menu allows you to access the online help files. 
Select Help on the Menu Bar to view the drop-down Help menu. 
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3.7 PC30A ADVANCED TOPICS 
 

3.7.1 Configuring PC30A for Distributed Use 
The PC30A can be used in a Distributed Configuration.  This configuration allows 
you to collect data and settings from Timers using “Frontline” PCs running PC30A, 
and then import that data into a centralized PC running PC30A.   
Using this configuration, you designate certain “Frontline” PC30A host computers 
at various locations to collect Raw Car Data from System 30 Timers via direct 
connections or modems as shown below.    
As each of these PC30As accumulate RCD from each store in its database (for its 
use in reporting, etc. at that PC30A location), the data is also made available for 
transfer to a “Central” PC30A that incorporates it into a central database.    
Note:  This configuration requires the following: 
! You will need to supply the means to copy the data from the Frontline PC to the 

central database using RCD files. 
! That you manually import RCD files into the Central PC30A. 
 
 

 
Figure 11.    Typical PC30A distributed-use configuration 
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The procedure for importing data from Store Timers into “Frontline” PC30As is 
described in PC30A Basics. 
The procedure for importing Raw Car Data from “Frontline” PC30As into a central 
database is as follows: 
1. Set up the central PC30A and the Frontline PC30As by adding the stores  

assigned to each.  For example Frontline PC30A #1 may have Store ID’s 1000, 
1001, and 1002 assigned to it.  In this case, these store IDs should be added to 
both Frontline PC30A #1 and the central PC30A, using the Editing Stores 
menu. NOTE:  All of the fields for each Store must be entered for the Frontline 
PC30A.  Only the Store ID and a fake phone number must be entered for each 
store at the central PC30A.   

2. Set up each Frontline PC30A to collect data from each store timer into its 
database at a specified frequency (see Editing Options).  This will cause the 
Frontline PC30A to also collect RCD in a file for a given store using the 
following naming format:   STORE_ID of Store_RCD Transfer.txt, where 
ID_of_Store is the store ID entered for a given store (see Editing Stores).   

3. PC30A will store this file in a folder located at:   
\Program\Files\Hme\PC30A\Database\ActivePC30AdbStore\ID_of_Store\Rcd, 
or at an alternate location that may have been selected by the installer when the 
PC30A was installed. 

4. Using a transfer software such as PC-Anywhere®, located with the Central 
PC30A, connect to each frontline PC30A and transfer the entire contents of the 
following folder from the Frontline PC30A:   
    \Program Files\Hme\PC30A\Database\ActivePC30AdbStore\ID_of_Store  
to the same folder on the central PC:   
    \Program Files\Hme\PC30A\Database\ActivePC30AdbStore\ID_of_Store  

5. Using the Central PC30A, import the STORE_ID of Store_RCD Transfer.txt 
into the active database using the procedure described in Importing and 
Exporting Raw Car Data Files.  Now the central PC30A has the same data as 
the Frontline PC30A. 

6. In addition to gathering data into a Central PC30A, it is possible to distribute 
portions of the database from a Central PC30A site to higher-level sites  
(such as regional managers who may only require portions of the total 
database that apply to their stores).  In such cases, follow the procedures in 
steps 1-4; only selecting the stores of interest to be entered and imported at 
the higher-level sites. 
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3.7.2 Importing and Exporting Raw Car Data Files 
The PC30A is able to import RCD from two sources: 
1. Store Timers 
2. Text Files 
 
PC30A Basics describes how the PC30A collects data from Store Timers.  Another 
approach is discussed in PC30A Advanced Topics: Configuring PC30A for 
Distributed Use, for collecting RCD from multiple groupings of stores without 
having to collect the data directly from each store.   
PC30A is also able to export RCD to a Tab or Comma delimited text file for use in 
3rd party applications such as spreadsheets, etc. 
 
Raw Car Data 
 
The Raw Car Data menu opens 
another menu with 2 choices: 
! Import from text file … 
! Export to text file …  

 
 
 
 

 
Import from text file … 
 
The Import from text file… menu opens the Import RCD Text File into Active 
Database dialog box, which is used to import the Raw Car Data text delimited files 
and settings files into the PC30A Database.  This feature is used for the PC30A 
configurations in which data can be collected from several timers by more than one 
PC30A, then imported to one central PC30A’s Database.   
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The Import RCD Text File into Active Database dialog box is used to select a 
store, for which the Raw Car Data will be imported, and the Raw Car Data text file 
to be imported.  PC30A will import Raw Car Data and save it under the store ID 
that is found in the text file.  If the Store ID does not already exist in the Database, 
these records will not appear in the any reports, even though they have been 
imported.  Store ID’s in the Store List must match Store ID’s of timer where Raw 
Car Data is being acquired.  PC30A will import only those Raw Car Data records 
that match the store ID selected on the grid.  PC30A will not import records, which 
already exist in the database. 
The Stores grid in the dialog box is used to select the store for which the Raw Car 
Data will be imported.  The store can be selected with a mouse click on the row 
containing the store, or using Up/Down keys of the keypad. 
The Select File button is used to select the text file to be imported.  Selecting the 
Select File button opens a standard windows File Open dialog box, which allows 
selecting the directory and the file name of the Raw Car Data text file.  After the file 
has been selected, a path and file name are displayed above the Status Bar. 
The Import button is used to start the import process.  Selecting the Import button 
will activate the Progress Bar at the bottom of the dialog box.  The Progress Bar 
indicates the PC30A is busy importing data, but does not show the overall 
percentage of the completed task. 
After the entire file has been read and appropriate data records have been 
imported, the number of records imported will be shown above the Status Bar. 
  
The Close button is used to close the dialog box.  Selecting the Close button will 
abort any import in progress. 
 
NOTE:  In the PC30A Database, a unique Raw Car Data record is defined by 
Store ID, lane number of the event, and event time.   
 
NOTE:  each unique RCD record imported into the Active Database is inserted in 
sorted order. 
 
Export to text file … 
 
The Export to text file… menu opens the Export RCD into Text File dialog box, 
which allows you to export the Raw Car Data into text-delimited file.  This feature is 
used for the PC30A configurations in which different PC30A installations share data. 
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The Export RCD into Text File dialog box is used to select a store, whose Raw 
Car Data will be exported, creating a Raw Car Data text file.  PC30A will export 
only those Raw Car Data records that match the Store ID selected on the grid, and 
that lie within the Start - Stop range selected on the dialog box. 
 
NOTE:  For PC30As used in a Distributed Configuration, settings files must be 
transferred together with the exported file.  Without the settings files, PC30As will 
not be able to import Raw Car Data text files. 
 
The Stores grid shows the Store ID, Store Name and the type of Connection to 
that store’s timer.  The store whose Raw Car Data will be exported can be selected 
with a mouse click on the row of the grid containing that store, or by using up and 
down arrow keys of the keypad. 
 
The Date and Time settings are used to limit the time range of the Raw Car Data to 
be exported.  Changing the Start or Stop dates and times will affect how many 
records are exported to the text file. 
 
The Tab and Comma selections in the dialog box allow you to select the text file 
format.  Selecting Tab will format the Raw Car Data text file with columns 
separated by tabs, whereas selecting Comma will separate the data columns with 
commas. 
 
The Select File button is used to select the text file to be exported.  Selecting 
Select File button opens a standard windows File Save dialog box, which allows 
selecting the directory and the file name of the Raw Car Data text file.  After the file 
has been selected, a path and file name will be displayed above the Status Bar. 
 
The Export button is used to start the export process.  Selecting the Export button 
will activate the Progress Bar at the bottom of the dialog box.  The Progress Bar 
indicates the PC30A is busy exporting data, but does not show the overall 
percentage of the completed task. 
 
After the entire file has been written and appropriate records have been exported, 
the dialog box will show the number of records exported above the Status Bar. 
 
The Close button is used to close the dialog box.  Selecting the Close button will 
abort any export in progress. 



 86 

3.7.3 Maintaining Your Database 
As described in the PC30A Basics, the PC30A Application uses a database file to 
collect Store Timer and Raw Car Data over long periods of time.  As the PC30A’s 
database grows due to on-going collection of RCD over long periods of time, you 
will need to perform maintenance on the database.  PC30A offers you two 
functions for maintaining the database: Archiving the Active Database and 
Compacting the Active Database. 
 
The Active Database menu opens another menu with 2 choices: 
! Create Archive … 
! Compact and Repair …  

 
 
Create Archive 
 
The Create Archive menu is used to back up all the active database’s stores, raw 
car data and settings files in a separate directory.  This should be done on a 
periodic basis to limit the size of the active database to below 980MB.   Even 
though you have an option to limit the number of years stored in the database for 
each store (in the Editing Options), the database file may grow beyond the Active 
Database limit within the allowable time period. 
NOTE:  Archiving the Active Database will move all of your RCD into the Archive 
Database, thus clearing the Active Databases Raw Car Data.  
 
Prior to initiating a manual or scheduled RCD Acquisition session, PC30A 
evaluates the Active Database file size and the available space on your hard drive.  
Although the MS Access™  database supports file size up to 1GB, PC30A limits 
the size of the active database file to a maximum of 980 MB.  PC30A generates a 
warning if file size grows beyond 931 MB (For example, if the database file size is 
960KB, following message will appear:   

9142: File C:\ProgramFiles\HME\PC30A\Database\ActivePC30Adb.mdb is 960000KB.  
PC30A will not run when Database file size exceeds 980000KB.   
Please make an archive of the database using File->Database->Archive menu.).  

Also, PC30A generates a warning if the available hard disk space drops below 
31.5MB (for example, if the available space on the C:\ drive is 31MB, following 
message will appear:   

9140: Drive C:\ contains only 31000KB.  
PC30A will not run when C:\ will contain 30000 KB of free space.   
Please make more space available by deleting some files.).  

These warnings are visible on the error bar of the PC30A’s main screen, and are 
logged to a file. 
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NOTE: PC30A generates an error and stops acquiring data from the store timer if 
file size exceeds 980MB, and displays the following message:   

9141: File C:\ProgramFiles\HME\PC30A\Database\ActivePC30Adb.mdb is  
980000KB, which exceeds the capacity of Database.    
Please make an archive of the database using File->Database->Archive menu. 

NOTE: PC30A generates an error and stops acquiring data from the store timer if 
the available hard disk space drops below 30MB, and displays the following 
message:   

9139: Drive C:\ contains only 30000KB, which is not enough to run PC30A.   
Please make more space available by deleting some files.    

These errors are visible on the error bar of the PC30A’s main screen, and are 
logged to a file.   
Creating an archive database destroys all of the RCD in the active database, but 
leaves all stores and settings.  The archived database and settings can be used to 
generate reports, but not for connecting to a store or data acquisition. 
Selecting Create Archive…  menu opens a warning dialog box.  
 

 
 
! Selecting Yes will take you to the Select a file name for Database Backup 

dialog box, with a default archive database name “PC30ABackup.MDB”, which 
is located in the …app_path\ArchiveDB\ directory. 

! Selecting No will close the dialog box with no changes to the active database 
! Selecting Help will bring up the PC30A Help 
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This dialog box is used to select the file name and a directory for the archive 
database.  The selected directory and file name for the archive database are also 
used to create a directory with the stores settings.  The directory containing stores 
settings is designated by adding “Stores” to the name of the archive database and 
storing it in the same directory as the archive database (e.g.: using archive 
database name PC30ABackup.MDB in the directory …\ArchiveDB\, the directory 
for the stores’ settings is …\ArchiveDB\PC30ABackupStores\). 
 
NOTE:  PC30A does not allow the archive database name to be same as an 
existing file in the selected directory.  To make another archive with the same 
name and in the same directory, manually delete the old archive and the stores 
settings folders. 
! Selecting Save will start the archive process, or… 
! Selecting Cancel will close the dialog box.  
 
After Save is selected, the Application status of the PC30A will change to 
“Archiving…” and the RCD scheduler will be disabled to prevent access to the 
active database while it is being emptied. 
After the archive has been created and all the settings files have been copied, the 
application status on the status bar will be changed to “Ready” and the RCD 
scheduler will be re-enabled to acknowledge that the process has been completed 
successfully. 
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Compact and Repair 
 
The Compact and Repair menu is used to compress the database file after the 
Raw Car Data has been imported into the active database from the System 30 
Timer, either manually or as scheduled.  Compacting the database reduces the 
size of the file by storing the Raw Car Data more efficiently and deleting Raw Car 
Data records which do not belong to any of the stores in the Stores table.   
IMPORTANT!  -  It is recommended that the active database be compacted at 
least once a week! 
Selecting Compact and Repair will open the warning dialog box which informs 
that PC30A will suspend responding to user activity while the active database is 
being compacted.   
 

 
 
! Selecting Yes  will initiate the compact and repair process, changing the 

application status to “Compacting.”   
! Selecting No will close the dialog box. 
! Selecting Help will bring up the PC30A Help 
 
After PC30A finished compacting and repairing the database, the application 
status will change to “Ready” to acknowledge that the process was successful. 
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3.8 PC30A ERROR CODES 
 
 
Error # Error Code Description 
70 
 

PERMISSION_DENIED Permission denied. 

75 FILE_ACCESS_ERROR Path/File access error. 
76 PATH_NOT_FOUND Path not found. 
3021 RS_EMPTY_ERROR  
3356 DB_EXCLUSIVELY_OPEN Original message 
8000 S30PortOpen  
8056 S30Timeout  
8067 S30Abort Scheduled Report Generation is Aborted. Or original message 

"request aborted." 
8068 S30CommandRejected System 30 Timer did not understand request from PC30A. 
8080 S30BadIPAddress Bad Remote Network Host IP Address Setting 
8081 S30BadIPPort Bad Remote Network IP Port Setting 
8082 S30IPConnectionFailed Exhausted retries to establish Network IP session 
8083 S30IPConnectionClosed Network IP session is closed by the remote host 
8102 API30SettingsFileCorrups Settings files from System 30 Timer are invalid. 
8130 API30NoDataFromTimer There is no new Raw Car Data since the last connection to this 

Store. 
Installer Settings Group Errors 
8140 Invalid lane configuration 
8141 Cannot put Internal Printer 
8142 Cannot put External Printer 
8143 Cannot put Service Idle Limit 
8144 Cannot put Queue Limit 
8145 Cannot put Max Cars in Queue 
8146 Cannot put Detection Point Delay 
8147 Cannot put Detection Point Type 
8148 Cannot put Detection Point Event Type 
8149 Cannot put Begin Discard 
8150 Cannot put End Discard 
8151 Cannot put Control Select 
8152 Cannot put Control Start Time 
8153 Cannot put Control Stop Time 
8154 Cannot put Control Start Day 
8155 Cannot put Control Stop Day 
8156 Cannot put Start Total Detector Index 
8157 Cannot put Stop Total Detector Index 
8158 Cannot put Start Detector Edge 
8159 Cannot put Stop Detector Edge 
8160 Cannot put Adjustable Total Mode 
8161 Cannot put Baud Rate 
8162 Invalid input file string 
8163 Violation of rules 
Miscellaneous Settings Group Errors 
8170 Cannot put Report Setting 
8171 Cannot put Day Option 
8172 Invalid input file string 
Report Settings Group Errors 
8180 Cannot put Hour Range 
8181 Cannot put Daypart Range 
8182 Cannot put Shift Range 
8183 Cannot put Day Range 
8184 Cannot put Every Car Schedule 
8185 Cannot put Hour Schedule 
8186 Cannot put Daypart Schedule 
8187 Cannot put Shift Schedule 
8188 Cannot put Day Schedule 
8189 Cannot put Week Schedule 
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8190 Cannot put Month Schedule 
8191 Cannot put Year Schedule 
8192 Cannot put Day Time 
8193 Cannot put Week Time 
8194 Cannot put Month Time 
8195 Invalid input file string 
8196 Violation of rules 
System Settings Group Errors 
8200 Cannot put Store ID 
8201 Cannot put Manager Code 
8202 Cannot put Report Code 
8203 Cannot put Version 
8204 Cannot put Config Time 
8205 Cannot put First Day of the Week 
8206 Cannot put First Month of the Year 
8207 Cannot put First Day of the Year 
8208 Cannot put Store Hours 
8209 Cannot put Shift Hours 
8210 Cannot put Daypart Hours 
8211 Invalid input file string 
8212 Violation of rules 
8213 Timer version differs from the file version 
Master Service Goals Group Errors 
8220 Cannot put Detector ID 
8221 Cannot put Event Type 
8222 Cannot put specified Goal 
8223 Invalid Event index 
8224 Invalid input file string 
8225 Violation of rules: 
Daypart Service Goals Group Errors 
8230 Cannot put specified Goal 
8231 Invalid Day index 
8232 Invalid Daypart index 
8233 Invalid Event index 
8234 Invalid input file string 
8235 Violation of rules: 
Remote Settings Group Errors 
8240 Cannot put Remote Flash Goal 
8241 Cannot put Remote Beep Goal 
8242 Cannot put Remote Beep Count 
8243 Cannot put Remote Tone Repeat Interval 
8244 Cannot put Remote Arrival Tone 
8245 Cannot put Remote Cars In Lane Tone Max 
8246 Cannot put Remote Cars In Lane Flash Max 
8247 Cannot put Remote Mode 
8248 Cannot put Remote Lane Number 
8249 Cannot put Remote Toggle Enable 
8250 Cannot put Remote Toggle Interval 
8251 Cannot put Remote Percent Goal 
8252 Cannot put Remote Percent Targ 
8253 Cannot put Remote Over Percent Color 
8254 Cannot put Remote Under Percent Color 
8255 Cannot put Remote Color Goal 
8256 Cannot put Remote Over Goal Color 
8257 Cannot put Remote Under Goal Color 
8258 Cannot put Remote Cars In Lane Color Max 
8259 Cannot put Remote Cars In Lane Tone Max 
8260 Cannot put Remote Cars In Lane Flash Max 
8261 Cannot put Remote Cars In Lane Under Max Color 
8262 Cannot put Remote Cars In Lane Over Max Color 
8263 Cannot put Remote Standby Interval 
8264 Cannot put Alarm Duration 
8265 Cannot put Alarm Interval 
8266 Cannot put Alarm Goal Index 
8267 Cannot put Alarm Mode 
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8268 Cannot put Alarm Lane 
8269 Cannot put Alarm Trigger 
8270 Cannot put Alarm Max Cars 
8271 Cannot put Remote Standby Mode 
8272 Invalid input file string 
8273 Invalid value for remote event 
8274 Violation of rules 
8275 Cannot put Remote Goal Event 
8276 Cannot put Remote Percent Event 
8277 Cannot put Remote Alarm Event 
 
9002 API_TAKEN Connection is already in use. 
9006 RCD_RETRY_ERROR Scheduler (e)Exhausted all retries for RCD acquisition. 

Check connection to the Timer / Modem. 
You also can change number of retries using Edit/Options/RCD 
Acquisition recovery/Maximum retries field . 

9007 RCD_RECORD_BAD RCD Record generated by API30 doesn't match the Lane 
configuration.  Refresh Store Settings. 
NOTE:  API30 is another software product that interfaces with 
PC30A. 

9100 DB_BAD_PHONE The phone number is invalid. Enter a valid phone number. 
9101 DB_BAD_BAUD_RATE The Baud Rate is invalid <incorrect baud rate>( No Baud Rate 

defined).  Select a valid Baud Rate from Edit/Stores menu. 
9102 DB_NO_STORE_ID Can't find Store <StoreID> in Database.  Add the Store before 

connecting. 
9103 DB_EMPTY_TABLE Database Global (Store) Table is empty. 

Use Edit/Options (Edit/Stores/Add) to enter the information. 
9104 DB_BAD_COM_PORT Comm port is invalid <incorrect comport>.  Select valid Comm 

Port in Edit/Options menu. 
9105 
 

INVALID_DB_FORMAT <DBname> is not a valid PC30A archive database.  Select a 
valid archive database.  

9106 RCD_SELECTION_EMPTY Active database does not have data for Store <StoreID>.  
Update database for the specified Store. 

9107 RCD_CRITICAL_ERROR Internal PC30A error 
9108 BAD_START_TIME Start time is not within Database range [… - …].   Select valid 

time within the DB range. 
9109 BAD_STOP_TIME Stop time is not within Database range[ …. - …..].  Select valid 

time within the DB range. 
9110 BAD_START_STOP_TIMES Start time must be less than Stop time.[Start = …- Stop = …]. 

Select valid time within the DB range. 
9111 START_STOP_LESS_ 

THAN_DB_RANGE 
Stop time is not within Database range [ …-  …].  Select valid 
time within the DB range. 

9112 START_MORE_THAN_YEAR_OLD MM/DD/YY is less than <…>.  Start time is not within one year 
from the current date. 

9113 START_NOT_IN_CURRENT_YEA
R 

MM/DD/YY is not withing <YYYY>. Start time is not within the 
current year. 

9114 TIMER_NOT_CONNECTED Connection was timed out. Reconnect to a Store Timer to 
retrieve the report 

9115 SETTINGS_MISSING Cannot find settings for the Store < storeID >.  Refresh the 
settings for the selected Store. 

9116 DP_IS_OFF Daypart <XX>  is OFF.  Select a valid daypart number. 
9117 SHIFT_IS_OFF Shift <XX>  is OFF.  Select a valid shift number. 
9118 REPORT_BUSY Report is locked by <name of the running report>.   Please 

wait... 
9119 SOME_REPORTS_FAILED <XX> out of <XX> reports are outside of the database range and 

cannot be generated.  Set correct dates and get report again. 
9120 REPORT_RANGE All requested reports failed.  Check report dates against the 

database range. 
9121 
 

DB_FIXED <current date> Database is corrupted (into Log). 
Following Items are corrupted and have been Fixed … 

9122 DB_GLOBALS_IVALID GLOBAL SETTINGS TABLE ….< and then composed 
description which fields are invalid> 

9124 DB_SETTINGS_IVALID Update settings for this store before updating RCD. 
9125 DB_STORES_IVALID STORES SETTINGS TABLE: Store# XX …..< and then 

composed description which fields are invalid> 
9126 PC30A_INACTIVE The connection has been terminated due to inactivity. 
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 Reconnect. 
9128 REPORT_NOT_IMPLEMENTED Report is not implemented. 

For Every Car Report need to show : 
Use Raw Car Data database report instead. 

9129 DB_STORES_EMPTY_TABLE Database Store Table is empty. 
Use Edit/Stores/Add to enter the information. 
No Stores Defined.  Add at least one store. 

9130 PC30A_PERMISSION_DENIED Close the Database prior to making an archive database. 
9131 PC30A_PATH_NOT_FOUND Cannot find directory < path for directory>. 
9132 PC30A_DB_EXCLUSIVELY_OPEN  
9133 RP_DAYPART_ARRAY Invalid daypart settings.  Refresh Store settings before obtaining 

the report. 
9134 RP_ADJUSTABLE_ARRAY Invalid adjustable totals array. Refresh Store settings before 

obtaining the report. 
9135 DUPLICATE_STOREID StoreID <StoreID> already exists in the Database.  Assign a 

new ID to this store. 
9136 NO_REPORTS_SCHEDULED No Reports are scheduled at this time or not enough data to 

generate reports.  Try creating Manual Summary Reports from 
Database. 

9137 INVALID_DATE_FORMAT The value you have entered is not a valid date.  Please check 
the value and type it again. 

9238 INVALID_TIME_T_RANGE Date  <date> is not a valid date to use with PC30A. 
9139 NOT_ENOUGH_FREE_SPACE_O

N_DRIVE 
Drive <drive> contains only <kbytes>KB, which is not enough to 
run PC30A.  Please make more space available by deleting 
some files 

9140 NOT_ENOUGH_FREE_SPACE_O
N_DRIVE_WARNING 

Drive <drive> contains only <kbytes>KB.  PC30A will not run 
when <directory> will contan 30MB of free space.  Please make 
more space available by deleting some files. 

9141 DB_FILE_SIZE_ERROR File <file> is <kbytes>KB, which exceeds the capacity of 
Database.  Please make an archive of the database using File-
>Database->Archive menu. 

9142 DB_FILE_SIZE_WARNING File <file> is <kbytes>KB. PC30A will not run when Database file 
size exceeds 980MB.  Please make an archive of the database 
using File->Database->Archive menu. 

9143 PC30A_DISK_FULL Destination does not have enough free space to create archive.  
Please free some space and try again. 

9144 SCHEDULER_IS_BUSY_ERR Scheduler is busy.  Try again later. 
9146 RECORDSET_ACCESS_ERROR The DB Connection used to open record set is invalid. 
9147 RS_NULL_ERROR Cannot open record set because RS is NULL.  Please create the 

record set before attempting to open it. 
9148 CONNECTION_NULL_ERROR Can not open Connection because connection pointer is NULL.  

Please create the Connection before attempting to open it. 
9150 INVALID_REPORT_ERR Invalid report source type. 
9151 SAVE_FAILED Unable to export report. Please obtain report again and repeat 

the export sequence. 
9155 SETTINGS_PUT_ERROR Invalid Setting Value. (<value>) 
9156 INVALID_ADJUST_TOTAL_EDGES System30 Timer has invalid Adjustable Start/Stop detector 

edges settings. 
9157 NOT_SUPPORTED_LANE_CONFI

GURATION 
PC30A does not support <lane> lanes configuration. 

9158 USER_CANCEL Choose a different name 
35773 
 

DTP_RANGE_ERROR1 Original message 

35774 
 

DTP_RANGE_ERROR2 Original message 

32755 FILE_CANCEL_ERROR   
 




